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About This Guide

IMPORTANT! Before using this product, read and understand the information the

“Safety” appendix in this document.

Revision history

Revision Date Description
A October 2006 New document.
B March 2007 Add Experiments and Results chapter.
C December 2010 Change to limited licensing information.
D April 2011 Change to limited licensing information.
E March 2012 Change to limited licensing information.
F August 2012 e Add 3500 and 3500xL Genetic Analyzer

information. Add GeneMapper® /D-X Software
information.

¢ Add validation experiments and results for
buffer and enzyme kit component changes.

Purpose

The AmpF(STR® MiniFiler™ PCR Amplification Kit User Guide provides information
about the Life Technologies instruments, chemistries, and software associated with the
AmpFlSTR® MiniFiler™ PCR Amplification Kit.
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B Materials and equipment ............. . i 16
Product overview
Purpose The AmpF(STR® MiniFiler™ PCR Amplification Kit is an assay optimized for

genotyping degraded and/or inhibited DNA samples. It is a short tandem repeat (STR)
multiplex assay optimized to allow direct amplification of single-source samples:

The MiniFiler™ Kit amplifies eight autosomal STR loci (D135317, D75820, D251338,
D21511, D165539, D18551, CSF1PO and FGA) and the sex-determining marker,
Amelogenin, in a single PCR reaction. The loci span a range between 70 to 283
nucleotides with the aid of non-nucleotide linkers to achieve appropriate spacing
between loci.

Product The MiniFiler™ Kit contains all the necessary reagents for the amplification of human
description genomic DNA.

The reagents are designed for use with the following instruments:
» Applied Biosystems® 3100/3100-Avant Genetic Analyzer
* Applied Biosystems® 3130/3130x! Genetic Analyzer
* Applied Biosystems® 3500/3500xL Genetic Analyzer
e Veriti® 96-Well Thermal Cycler (Part no. 4375786)
* GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

About the primers The MiniFiler™ Kit uses primers closely flanking the STR repetitive regions (miniSTRs)
of the DNA. This amplification results in amplicons that are significantly shorter in
length than those produced in the AmpF(STR® Identifiler® and SGM Plus® PCR
Amplification Kits. The comparison is shown in Table 1 on page 12. Several
laboratories confirm that MiniSTRs have a higher success rate for DNA analysis of
degraded DNA samples (Butler et al., 2003; Chung et al., 2004; Coble and Butler, 2005;
Drabek et al., 2004; Grubwieser et al., 2006; Wiegand et al., 2001).

To prevent overlap of the miniSTR amplicons in the multiplex, non-nucleotide linkers
are used in primer synthesis for the following loci: CSF1PO, FGA, D165539, D18551,
Amelogenin, D251338, D21511, and D7S820. For these primers, non-nucleotide linkers
are placed between the primers and the fluorescent dye during oligonucleotide
synthesis (Butler 2005, Grossman et al., 1994, and Baron et al., 1996). Non-nucleotide

AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide 11
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linkers enable reproducible positioning of the alleles to facilitate inter-locus spacing.
The combination of a five-dye fluorescent system and the inclusion of non-nucleotide
linkers allows for simultaneous amplification and efficient separation of the eight STR
loci and Amelogenin during automated DNA fragment analysis.

Locus MiniFiler Kit Amplicon Length Reduction
(nt)
D75820 -129
D13S317 -99
D215 -33
D251338 -183
Amelogenin 0

D18S51 -168
D165539 —157
FGA -87
CSF1PO —201

Loci ampl_ified by Table 1 shows the loci amplified, their chromosomal locations, and the corresponding

the kit fluorescent marker dyes. The AmpF(STR® MiniFiler™ Allelic Ladder is used to

genotype the analyzed samples. The alleles contained in the allelic ladder, and the
genotype of the AmpF(STR® Control DNA 007, are also listed in the table.

Table 1 AmpF(STR® MiniFiler™ PCR Amplification Kit loci and alleles

. . Chromosome . . . Dye Control
Locus designation location Alleles included in Allelic Ladder label DNA 007
D13S317 13q22-31 8,9,10, 11,12, 13, 14, 15 6-FAM™ 1
D75820 7911.21-22 6,7,8,9 10, 11,12, 13, 14, 15 7,12
Amelogenin X:p22.1-22.3 XY vIC® XY
Y:p11.2
D251338 2g35-37.1 15,16, 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 20, 23
27,28
D21S11 21911.2-921 24, 24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, 28, 31
30.2,31,31.2,32,32.2,33,33.2, 34, 34.2, 35,
35.2, 36, 37, 38
D165539 16q24-qter 58,910, 11,12, 13, 14, 15 NED™ 9,10
D18S51 18921.3 7,9,10,10.2, 11, 12, 13, 13.2, 14, 14.2, 15, 12,15
16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27
CSF1PO 5g33.3-34 6,7,8,9 10,11, 12,13, 14, 15 PET® 11,12
FGA 4q28 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, 27, 24, 26
28, 29, 30, 30.2, 31.2, 32.2, 33.2, 42.2, 43.2,
44.2, 652, 46.2, 47.2, 48.2, 50.2, 51.2
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Allelic ladder Figure 1 shows the allelic ladder for the MiniFiler " Kit. See “Allelic ladder
requirements” on page 26 for information on ensuring accurate genotyping.

Figure 1 GeneMapper® ID-X Software plot of the AmpF(STR® MiniFiler™ Allelic Ladder
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Workflow overview

Perform
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AmpF(STR® MiniFiler™ PCR Amplification Kit

Prepare
reactions
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Instrument and software overview

Data collection and

analysis software

Instrument and
software
compatibility

About
multicomponent
analysis

How
multicomponent
analysis works

This section provides information about the data collection and analysis software
versions required to run the this kit on specific instruments.

The data collection software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the data collection
software collects the data and stores it. The data collection software stores information
about each sample in a sample file (.fsa files for 31xx instruments and .hid files for 3500

instruments), which is then analyzed by the analysis software.

Instrument Operating system Data collection Analysis software
software
3100/3100- Windows® NT 1.1 (3100)  GeneMapper® ID
Avant 1.0 (3100-Avanf) Software v3.2.1
: ® e GeneMapper® ID-X
Windows™ 2000 2.0 Software v1.0.1 or higher
3130/3130x(* Windows XP 3.0
3500/3500xL e Windows® XP 3500 Series Data | GeneMapper® ID-X Software
or Collection v1.2 or higher
« Windows Vista® | >°ftware v1.0
310 Windows XP 3.1 GeneMapper ID 3.2
Windows NT and 3.0 GeneMapper /D 3.2
Windows 2000

+ We conducted validation studies for the MiniFiler™ Kit using these configurations.

Life Technologies fluorescent multi-color dye technology allows the analysis of
multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
overlapping loci are distinguished by labeling locus-specific primers with different

colored dyes.

Multicomponent analysis is the process that separates the five different fluorescent
dye colors into distinct spectral components. The four dyes used in the MiniFiler'" Kit
to label samples are 6-FAM™, VIC®, NED™, and PET® dyes. The fifth dye, LIZ®, is
used to label the GeneScan™ 500 LIZ® Size Standard or the GeneScan™" 600 LIZ® Size

Standard v2.0.

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on the Life Technologies instruments, the
fluorescence signals are separated by a diffraction grating according to their
wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM'" dye emits at the shortest wavelength and is
displayed as blue, followed by the VIC® dye (green), NED™ dye (yellow), PET® dye
(red), and LIZ® dye (orange).

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes (Figure 2).
The goal of multicomponent analysis is to correct for spectral overlap.

AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide
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Figure 2 Emission spectra of the five dyes used in the MiniFiler™ Kit
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Materials and equipment

Kit contents and
storage

The MiniFiler™ Kit (Part no. 4373872) contains sufficient quantities of the following
reagents to perform 100 reactions at 25 pL/reaction:

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Table 2 Kit contents and storage

Component Description 100 reaction Storage
AmpF(STR® MiniFiler™ Contains enzyme, salts, dNTPs, carrier 2 tubes, -15 to -25°C upon
Master Mix protein, and 0.05% sodium azide 0.5 mL/tube receipt, 2 to 8°C after
AmpF(STR® Control Contains 0.10 ng/uL human male genomic 1 tube, 0.3 mL initial use

DNA 007

DNA in 0.05% sodium azide and buffer.t
See Table 1 on page 12 for profile.

AmpF(STR® MiniFiler™ Contains forward and reverse primers to 1 tube, 0.5 mL -15t0 -25°C upon
Primer Set amplify human DNA targets. receipt.
AmpFZSTR® MiniFiler™ Contains amplified alleles. 1 tube, 0.05 mL 2 to 8°C after initial
Allelic Ladder See Table 1 on page 12 for a list of alleles use.
included in the allelic ladder. Store protected from
light.

t The Control DNA 007 is included at a concentration appropriate to its intended use as an amplification control (i.e., to provide confirmation of
the capability of the kit reagents to generate a profile of expected genotype). The Control DNA 007 is not designed to be used as a DNA
quantitation control and you may see variation from the labelled concentration when quantitating aliquots of the Control DNA 007.

16
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Standards for For the MiniFiler™ Kit, the panel of standards needed for PCR amplification, PCR
samples product sizing, and genotyping are:

e AmpF/STR® Control DNA 007 - A positive control for evaluating the efficiency
of the amplification step and STR genotyping using the AmpF(STR® MiniFiler"™"
Allelic Ladder.

e GeneScan'" 500 LIZ® Size Standard or GeneScan™ 600 LIZ® Size Standard
v2.0 — Used for obtaining sizing results. These standards, which have been
evaluated as internal size standards, yield precise sizing results for MiniFiler' " Kit
PCR products. Order the GeneScan" 500 LIZ® Size Standard (Part no. 4322682) or
the GeneScan'" 600 LIZ® Size Standard v2.0 (Part no. 4408399) separately.

* AmpF/STR® MiniFiler™ Allelic Ladder — Developed for accurate
characterization of the alleles amplified by the MiniFiler'" Kit. The Allelic Ladder
contains most of the alleles reported for the 16 autosomal loci. See page 12 for a
list of the alleles included in the Allelic Ladder.

AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide 17
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Required user-supplied reagents

In addition to the Identifiler® Kit reagents, the use of low-TE buffer (10 mM Tris,
0.1 mM EDTA, pH 8.0) is recommended. You can prepare the buffer as described in the
procedure below or order it from Teknova (Cat # T0223).

To prepare low-TE buffer:
1. Mix together:
e 10mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.
2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA gquantification

Importa nce of Quantifying the amount of DNA in a sample before amplification allows you to

quantification determine whether or not sufficient DNA is present to permit amplification and to
calculate the optimum amount of DNA to add to the reaction. The optimum amount of
DNA for the Identifiler® Kit is 1.0 ng in a maximum input volume of 10 uL for 28 PCR
cycles.

AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide 19
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DNA quantification

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

¢ Fluorescence intensity that exceeds the linear dynamic range for detection by the

instrument (“off-scale” data). Off-scale data are problematic because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

¢ Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur resulting in a partial profile.

Methods of
quantifying DNA

Life Technologies provides several kits for quantifying DNA in samples. See the
references cited in the following table for details about these Kkits.

Product

Description

Quantifiler® Human DNA
Quantification Kit
(Part no. 4343895)

and

Quantifiler® Y Human Male
DNA Quantification Kit
(Part no. 4343906)

For more information, see
Quantifiler® Human DNA
Quantification Kits User’s Manual
(Pub. no. 4344790)

Quantifiler® Duo DNA
Quantification Kit
(Part no. 4387746)

For more information, see
Quantifiler® Duo DNA
Quantification Kit User's Manual
(Pub. n0.4391294)

Properties:

The Quantifiler® Human and Quantifiler® Y Human Male Kits are highly specific for
human DNA, and they individually detect total human or male DNA, respectively. The
kits detect single-stranded and degraded DNA.

How they work:

The Quantifiler® DNA Quantification Kits consist of target-specific and internal control
5" nuclease assays.

The Quantifiler® Human and Quantifiler® Y Human Male Kits contain different target-
specific assays (human DNA or human male DNA, respectively] that each consist of two
locus-specific PCR primers and one TagMan® MGB probe labeled with FAM™ dye for
detecting the amplified sequence. The kits each contain a separate internal PCR control
(IPC) assay, which consists of an IPC template DNA (a synthetic sequence not found in
nature), two primers for amplifying the IPC template, and one TagMan® MGB probe
labeled with VIC® dye for detecting the amplified IPC.

Properties:

The Quantifiler® Duo Kit is highly specific for human DNA. This kit combines the
detection of both total human and male DNA in one PCR reaction.The kit detects single-
stranded and degraded DNA.

How it works:

The Quantifiler® Duo DNA Quantification Kit consists of target-specific and internal
control 5" nuclease assays.

The Quantifiler® Duo kit combines two human-specific assays in one PCR reaction (for
total human DNA and human male DNAJ. The two human DNA specific assays each
consist of two PCR primers and a TagMan® probe. The TagMan® probes for the human
DNA and human male DNA assays are labeled with VIC® and FAM™ dyes, respectively.
In addition, the kit contains an internal PCR control (IPC) assay similar in principle to
that used in the other Quantifiler kits, but labeled with NED™ dye.

20
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Prepare the amplification kit reactions

Prepare the amplification kit reactions

1. Calculate the volume of each component needed to prepare the reactions, using
the table below.

DNA sample Volume per reaction
AmpF(STR® MiniFiler™ Master Mix 10.0 pL
AmpF(STR® MiniFiler™ Primer Set 5.0 L

Note: The volumes indicated above include a slight overfill to account for the loss
that occurs during reagent transfers.

2. Prepare reagents. Thaw the PCR Reaction Mix and the Identifiler® Primer Set,
then vortex all reagent tubes, including the enzyme, for 3 seconds and centrifuge
briefly before opening the tubes.

IMPORTANT! Thawing is required only during first use of the Primer Set and PCR
Reaction Mix. After first use, these reagents are stored at 2 to 8 °C and do not
require subsequent thawing. Do not refreeze these reagents.

3. Prepare the reaction mix: Pipette the required volumes of components into an
appropriately sized polypropylene tube.

4. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

5. Dispense 15 uL of the reaction mix into each reaction well of a MicroAmp®
Optical 96-Well Reaction Plate or each MicroAmp® tube.

6. Prepare the DNA samples:

DNA sample To prepare...
Negative control Add 10 pL of low-TE buffer (10mM Tris, 0.1TmM EDTA, pH 8.0).
Test sample Dilute a portion of the test DNA sample with low-TE buffer so

that 0.5 to 0.75 ng of total DNA is in a final volume of 10 pL. Add
10 pL of the diluted sample to the reaction mix.

Positive control Combine 5 pL of control DNA (0.1 ng/uL) with 5 uL of low-TE
buffer for a total volume of 10 pL. (The final sample
concentration is 0.05 ng/uL.) Add to the reaction mix.

The final reaction volume (sample or control plus reaction mix) is 25 pL.

7. Seal the plate with MicroAmp® Clear Adhesive Film or MicroAmp® Optical
Adhesive Film, or cap the tubes.

8. Centrifuge the tubes at 3000 rpm for about 20 seconds in a tabletop centrifuge
(with plate holders if using 96-well plates).

9. Amplify the samples in a GeneAmp® PCR System 9700 with the silver or
gold-plated silver 96-well blocks or a Veriti® 96-Well Thermal Cycler.
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Perform PCR

Perform PCR

1. Program the thermal cycling conditions:

* When using the GeneAmp PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

e When using the Veriti® 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti® 96-Well Thermal Cycler
AmpF(STR® Kit Validation (Pub. no.4440754).

Initial Denature Anneal Extend Final Final hold
incubation step extension

HOLD CYCLE (30) HOLD HOLD

95°C 94°C 59°C 72°C 60°C 4°C

11 min 20 sec 2 min 1T min 45 min oo

2. Load the plate into the thermal cycler and close the heated cover.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, be sure to
place a MicroAmp® compression pad (Part no. 4312639) on top of the plate to
prevent evaporation during thermal cycling. The Veriti® Thermal Cycler does not
require a compression pad.

3. Start the run.

4. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
< 2 weeks 2 to 8°C
> 2 weeks -15t0-25°C

IMPORTANT! Store the amplified products so that they are protected from light.

Amplification using bloodstained FTA® cards

22

FTA® cards can be useful for collecting, storing, and processing biological samples. A
small punch disc of the card containing the sample can be placed directly into an
amplification tube, purified, and amplified, without transferring the disc. Our studies
indicate that a 1.2-mm bloodstained disc contains approximately 5 to 20 ng DNA. An
appropriate cycle number for this high quantity of DNA is 24 cycles as determined by
our validation studies. However, it is recommended that each laboratory determine
the optimum cycle number based on internal validation studies.

In the example shown in Figure 3, a 1.2-mm disc of a bloodstained FTA® card was
purified using three washes with FTA® Purification Reagent and two washes with

1X low-TE bulffer. The purified punch disc was then amplified in the MicroAmp® tube
for 24 cycles.
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Amplification using bloodstained FTA® cards

Figure 3 MiniFiler™ Kit results from a 1.2-mm FTA® bloodstain disc (24-cycle amplification), analyzed on the Applied
Biosystems 3130x( Genetic Analyzer

a0 a0 100 10 120 130 140 150 160 170 180 180 200 0 220 230 240 250 260 70 280 280

7
5000

4000

3000

2000

1000

AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide 23



2 Chapter 2 Perform PCR
Amplification using bloodstained FTA® cards

24 AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide



Perform Electrophoresis

Allelic ladder requirements. .. ...... ... ... 26
B Section 3.1 3100/3100-Avant and 3130/3130x] instruments . . ................ 27

Set up the 3100/3100-Avant and 3130/3130xI instruments for electrophoresis . . .27

Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130x1

INStruments. .. ... ... 28
B Section 3.2 3500/3500xLinstruments . ............otiuiinti i 29
Set up the 3500/3500xL instruments for electrophoresis ..................... 29
Prepare samples for electrophoresis on the 3500/3500xL instruments. ......... 29
B Section3.3 310Instrument.......... .. ... . ... 31
Set up the 310 instrument for electrophoresis . ............................. 31
Prepare samples for electrophoresis on the 310 instrument .................. 31

AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide 25



Chapter 3 Perform Electrophoresis

Allelic ladder requirements

Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples.

Number of One .
. L Number of samples per allelic
Instrument allelic ladders injection
ladderl(s)
to run equals

3100-Avant or 3130 | 1 per 4 injections | 4 samples 15 samples + 1 allelic ladder

3100 or 3130x{ 1 per injection 16 samples | 15 samples + 1 allelic ladder
3500 1 per 3 injections | 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples 23 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between both single- and multiple-capillary runs
(with larger size variations seen between samples injected in multiple-capillary runs).
We recommend the above frequency of allelic ladder injections, which should account
for normal variation in run speed. However, during internal validation studies, verify
the required allelic ladder injection frequency to ensure accurate genotyping of all
samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the
samples, because size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and electrophoretic
conditions.
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Set up the 3100/3100-Avant and 3130/3130x!l instruments for electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x!
instruments

Set up the 3100/3100-Avant and 3130/3130x! instruments for

electrophoresis

Reagents and parts

supplied with this kit.

Appendix C, “Ordering Information” on page 117 lists the required materials not

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect

the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Electrophoresis
software setup and

the documents listed in the table.

The following table lists data collection software and the run modules that can be used
to analyze PCR products generated by this kit. For details on the procedures, refer to

reference
documents
. Data .
Genetic Collection Operating Run modules and conditions References
Analyzer System
Software
Applied 1.0 Windows® e GeneScan36Avb_DyeSetG5Module = 3700/3100-Avant Genetic Analyzers
Biosystems® NT Injection condition: 3 kV/5sec Protocols for Processing AmpF(STR®
3100-Avant e GS600v2.0Analysis.as PCR Amplification Kit PCR Products
SANGYSIS.OSP User Bulletin (Part no. 4332345)
Applied 2.0 Windows® e HIDFragmentAnalysis36_POP4_1  3100/3100-Avant Genetic Analyzers
Biosystems® 2000 Injection condition: 3kV/10 sec Using Data Collection Software v2.0,
3100 e Dve Set G5 Protocols for Processing AmpF(ISTR®
y PCR Amplification Kit PCR Products
User Bulletin (Part no. 4350218}
1.1 Windows® e GeneScan3évb_DyeSetG5Module 3100/3100-Avant Genetic Analyzers
NT |njecti0n condition: 3kV/’|0 sec PrOtOCO[S fOF Processing AmpFlSTR®
. . PCR Amplification Kit PCR Products
G5600v2.0Analysis.gsp User Bulletin (Part no. 4332345)
Applied 3.0 Windows® e HIDFragmentAnalysis36_POP4_1  Applied Biosystems 3130/3130x!
Biosystems® XP Injection conditions: Genetic Analyzers Using Data
3130/3130x(t Collection Software v3.0, Protocols for

- 3130 = 3 kV/5 sec
- 3130x( = 3 kV/10 sec
Dye Set G5

Processing AmpFISTR® PCR
Amplification Kit PCR Products User
Bulletin (Part no. 4363787)

t+ We conducted validation studies for the MiniFiler™ Kit using the 3130x( configuration.

AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide
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3 Chapter 3 Perform Electrophoresis
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130x! instruments

Prepare samples for electrophoresis on the 3100/3100-Avant or
3130/3130x! instruments

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di'"" Formamide and size standard needed to prepare
the samples:

Reagent Volume_ per Reagent Volume_ per
reaction reaction
GeneScan™ 500 0.3 L OR GeneScan™ 600 0.5 pL
LIZ® Size Standard LIZ® Size Standard
v2.0
Hi-Di™ Formamide 8.7 uL Hi-Di™ Formamide 8.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.
4. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:

* 9 L of the formamide:size standard mixture
¢ 1 pL of PCR product or Allelic Ladder
Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

5. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Prepare the plate assembly on the autosampler.

Y ® N o

Start the electrophoresis run.
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Set up the 3500/3500xL instruments for electrophoresis

Section 3.2 3500/3500xL instruments

Set up the 3500/3500xL instruments for electrophoresis

Reagents and parts Appendix C, “Ordering Information” on page 117 lists the required materials not
supplied with this kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

w
a
o
o
w
a
o
o
x
=
>
(2]}
—
=
=
3
®
=)
-
(2

Electrophoresis The following table lists data collection software and the run modules that you can use
software setupand  t° analyze PCR products generated by this kit. For details on the procedures, refer to
the documents listed in the table.

reference
documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 1.0 Windows® e HID36_POP4 Applied Biosystems® 3500/
Biosystems® XP Injection conditions: 1.2kV/15 sec 3500xL Genetic Analyzer User
3500 Guide (Part no. 4401661)
or e Dye Set G5
Applied Windows HID36_POP4 3500 and 3500xL. Genetic
Bi ® o ® L ” Analyzers Quick Reference Card
losystems Vista Injection conditions: 1.2kV/24 sec (Part no. 4401662)
3500xL .

e Dye Set G5

Prepare samples for electrophoresis on the 3500/3500xL
instruments

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di™ Formamide and GeneScan™ 600 LIZ® Size
Standard v2.0 needed to prepare the samples:

Reagent Volume per reaction
GeneScan™ 600 LIZ® Size Standard v2.0 0.5 pL
Hi-Di™ Formamide 8.5 L

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.
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Prepare samples for electrophoresis on the 3500/3500xL instruments

2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.
4. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:

* 9 uL of the formamide:size standard mixture
* 1 uL of PCR product or Allelic Ladder
Note: For blank wells, add 10 uL of Hi-Di"" Formamide.

5. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

Heat the plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Place the sample tray on the autosampler.

©° ® N o

Start the electrophoresis run.
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Set up the 310 instrument for electrophoresis

Section 3.3 310 Instrument

Set up the 310 instrument for electrophoresis

Reagents and parts  “Ordering Information” on page 117 lists the required materials not supplied with the
AmpF(STR® Identifiler® PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.
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Electrophoresis The following table lists Data Collection Software and the run modules that can be
software setup and used to analyze Identifiler® Kit PCR products. For details on the procedures, refer to
the documents listed in the table.

reference
documents
Data Operatin
Collection P 9 Run modules and conditions References
System
Software
317 Windows XP e GS STR POP4 (1mL]) G5 v2.md5 = 370 Genetic Analyzer User’'s Manual (Windows)
or or Injection condition: (Pub. no. 4317588)
3.0 Windows® 15 kV/5 sec 310 Protocols for Processing AmpF(STR® PCR
NT and Amplification Kit Products with Microsoft Windows
Windows NT Operating System: User Bulletin
2000 (Pub. no. 4341742)

+ We conducted concordance studies for the Identifiler® Kit using this configuration.

Prepare samples for electrophoresis on the 310 instrument

Prepare the samples for electrophoresis immediately before loading.

1. Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GeneScan™ 500 LIZ® Size Standard or 0.5 uL
GeneScan™ 600 LIZ® Size Standard v2.0
Hi-Di"™ Formamide 24.5 ul

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.
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Prepare samples for electrophoresis on the 310 instrument

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

2. Pipette the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each 0.2 mL sample tube, add:
® 25 uL of the formamide:size standard mixture
e 1.5 pL of PCR product or allelic ladder
Note: For blank wells, add 25 puL of Hi-Di"™ Formamide.

5. Seal the tubes with the appropriate septa, then briefly centrifuge to ensure that
the contents of each tube are mixed and collected at the bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95°C.
Immediately place the tubes on ice for 3 minutes.
Place the sample tray on the autosampler.

Ensure that an injection list is prepared.

© 0 ©® = o

Start the electrophoresis run.
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Section 4.1 GeneMapper® ID Software

Overview of GeneMapper® ID Software

Instruments

Before you start

GeneMapper® ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the Data Collection Software stores information for each sample
in an .fsa file. Using GeneMapper® ID Software v3.2.1 software, you can then analyze
and interpret the data from the .fsa files.

Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.

When using GeneMapper® ID Software v3.2.1 to perform human identification (HID)
analysis with AmpF(STR® kits, be aware that:

¢ HID analysis requires at least one allelic ladder sample per run folder. Perform

the appropriate internal validation studies if you want to use multiple ladder
samples in an analysis.

For multiple ladder samples, the GeneMapper® ID Software calculates allelic bin
offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.
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When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

¢ Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

¢ Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

* Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory’s protocol.

Set up GeneMapper® ID Software for data analysis

File names

Before using the
software for the
first time

Import panels and
bins

34

The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID Software.

To analyze sample files (.fsa) using GeneMapper® ID Software v3.2.1 for the first time:

* Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 34.

* Create an analysis method, as explained in “Create an analysis method” on
page 38.

¢ Create a size standard, as explained in “Create a size standard” on page 43.
* Define custom views of analysis tables.

Refer to the GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification
Analysis Tutorial (Part no. 4335523) for more information.

¢ Define custom views of plots.

Refer to the GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification
Analysis Tutorial (Part no. 4335523) for more information.

To import the latest panel and bin set from the our web site into the GeneMapper® ID
Software v3.2.1 database:

1. Download and open the file containing panels and bins:

a. Go to www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID Software. Download the file
GMID_MiniFiler_files.

b. Unzip the file.
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Set up GeneMapper® ID Software for data analysis

2. Start the GeneMapper® ID Software, then log in with the appropriate user name
and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID Software Version
3.1 Human Identification Analysis User Guide (Part no. 4338775).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels and bins:

a. Select Panel Manager in the navigation pane.

[#) Panel Manager

b. Select File » Import Panels to open the
Import Panels dialog box.

File Edit Bins View

=1 IL RN T EaE 1

== Panel Manager

c. Navigate to, then open the MiniFiler
Analysis Files GMID folder that you
unzipped in step 1 on page 34.

)
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5. Select AmpFLSTR_MiniFiler_GS500_Panels_v1.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, AmpFISTR_MiniFiler_GS500_Panels_v1. This folder contains the panel
and associated markers.

[#]) Import Panels

Look in: |@ tiriFiler Analysiz Files GMID i~ | I ,5'|| E
Ty [Z] AmpFLSTR_MiniFiler_5S500_Bins_wi txt
[ 3 B AmpFLSTR MiniFiler_GS500_Panels_wl i
iy Recent MiniFiler _GS300_HID w1 =l
Documetts
?L-:

Desktop

‘j File narme: | AmpFLETR_MiniFiler_G=300_Panels_w1 tat |
My Documents | Files of type: |,a,|| Files v | Cancel

6. Import the bins file:

(7] Panel Manager,
File Edit Bins ‘iew
B X | W E M s

B AmpFLSTR_MiniFiler_Panels_v1
CAMiniFiler_GS500_w1

a. Select the
AmpFISTR_MiniFiler_ GS500_Panels_v1 folder
in the navigation pane.

b. Select File » Import Bin Set to open the Import
Bin Set dialog box.

c. Navigate to, then open the MiniFiler Analysis Files GMID folder.
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d. Select AmpFLSTR_MiniFiler_GS500_Bins_v1.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AmpFISTR_MiniFiler_GS500_Panels_v1 folder.

L"\,b @ AmpFLSTR_MiniFiler_GS500_Panels_w1 tx
My Recent MiniFiler _GS500_HID_v1 xml
Documerts

?’[_'_'

Desktop

] Flename: | AmpFLSTR_MiniFiler_GS500_Bins_v! xt |
Wy Documents | IS of type: |AII Files v| Cancel

7. View the imported panels in the navigation pane:

a. Double-click the AmpFISTR_MiniFiler GS500_Panels_v1 folder to view
the MiniFiler_GS500_v1 folder.

b. Double-click the MiniFiler_GS500_v1 folder to display the panel
information in the right pane.

[#) Panel Manager

File Edit Bins View
G X H EE BN M snse |AmpFLSTR_MiniFiIer_GSSDD_.._ v| RN N CIO000n
B EIPanel Marmger - Maker Hane  |Dye Color | Min Sise |Mx Sime | Comtrol Alleles Bazkcer || Miker §| Conuments Ladder Alleles
L AmpFLSTR_vfiler_Panel_v2 1 Pis=air Jewe  [soo 1330 |1 4 014 |nane §:9,10,11,12,13,1¢
= EDAmpFLSTR MinFiler_GS500_Panets_vi 2 |prsszo blue 1415 1935 |742 4 041 |none 67891011121
3 |AMEL green 99.3 109.3 R 9 0.0 none Y
4 |D2s1338 green  [1108  [1793  |2023 4 018 |nane 15,1617 ,18,19,20
|5 o2z green  [1806  |2506  |28,31 4 016  |nane 24242252627 2
0231333 & |D163539 yellow |70.0 1220|910 4 045 |none 55910111213,
31215215139 7 |D1asst yelow [1224  |2104  [1215 4 018 |nane 79101021112,
fp— & |CEFIPO red 846  [1326  [1112 4 014 |nane 67,69,10,11,12,1
CEFIPO a |FGa red 1364|2964 |2426 4 015  |nane 17,18,19,20,21 22
_ FiGA b (_ | z
=IReference Samples
[ Ok ] [ Cancel ] [ Apply ]
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8. Select D2S1338 to display the Bin view for the marker in the right pane.

[#) Panel Manager

File Edit Bins View
X 3 = B M Bin et |ampFLSTR MiniFiler_GS500_.. v| ‘ B BE O |i|i|i|i|. [ ]

= EPanel Manager -~
[ ampFLSTR_vfiler_Panel_vw2 | 14/ 15 |16 17 18| 19 (20| 21 22| 23 |24 25 26 27 |28 29
=] ﬁAmpFLSTR_MiniFiIer_GSSDD_PaneIS_v1
= ESMiniFiler_GS500_v1
0135317
D7sE20

AMEL

025133
D251
[ME5539

D1Es51

CEF1PO

FGA, b

=IReference Samples

0
106 112 118 124 130 136 142 145 154 160 166 172 175 164

Dz51338

)
()
>
()
=
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=
(V)
=
()

[ Ok H Cancel H Apply ]

9. Click Apply, then OK to add the panel and bin set to the GeneMapper® ID
Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels and
bins are not imported into the GeneMapper® ID Software database.
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Create an analysis  Use the following procedure to create an analysis method.

method
1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
(7] GeneMapper Manager
| Tahle Settings || Plat Settings || Matrices || Size Standards
[Marne Last Saved Cner Instrurment Analysis Type Description
IdentifilerDirect_HID_w1 2010-05-05 10:24:1 | amicd HID Default Identifiler O -
Identifiler_Plus_asnalysisMet |2011-05-19 14:41:1 | amid HIC Default analysis |-
Microsatelite Default 2010-01-27 14:58:0 | gmic Microsatellite Factory Provided 3
< [ 3]
Daone
2. Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.

3. Select HID and click OK to open the Analysis Method Editor with the General tab
selected.

4. Enter the settings shown in the figures on the following pages.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

5. After you enter settings in all tabs, click Save.

General tab . ) !
. Analysis Method Editor - HID rg|
settings
| General | aele | Peak Detectar | Peak Quality | Gualty Flags
&nalysis Method Description
Marne: | MiniFler_Analysishethod_w1 |
Description: ~
w
Instrument:
Analysis Type: HIC:

In the Name field, either type the name as shown for consistency with files supplied
with other AmpF(STR® kits, or enter a name of your choosing. The Description and
Instrument fields are optional.
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Allele tab settings

Analysis Method Editor - HID

General| Allele | Peak Detector | Peak Guslity | Suslty Flags

Ein Siet: ArmpFLSTR_MiniFiler
Use marker-specific stutter ratio if available

Marker Repeat Type Tri Tetra Penta Hexa

Cut-off Value on an on i}

Mirus 4 Ratio oo oo oo 0.0

hirusA, Distance From |00 0o oo [ifi}
Ta |00 oo on [fn}

Minuzs Stutter Ratio oo 0o on [ifi}

Minuz Stutter Distance Fram |00 3.25 on [fn}
To |00 475 oo oo

Plus Stutter Ratio oo an on 0.0

Pluz Stutter Distance From |00 0o oo [ifi}
To |00 an oo 0.0

Amelogenin Cutoff

Range Fifter ... Factory Defaults

* In the Bin Set field, select the AmpFLSTR_MiniFiler_Bins_v1 bin set imported
previously and configure the stutter distance parameters as shown.

* GeneMapper® ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

* Specify the peak filter ratios:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the MiniFiler_GS500_v1 file, select
the “Use marker-specific stutter ratio if available” check box (selected by
default). Perform appropriate internal validation studies to determine the
appropriate filter setting to use.

¢ To specify an Amelogenin Cutoff Ratio, enter the appropriate ratio into the
Amelogenin Cutoff field.

Note: Do not use an Amelogenin cutoff for data that may contain mixtures of
male and female DNA
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Set up GeneMapper® ID Software for data analysis

Peak Detector tab x|
. Analysis Method Editor - HID
settings —
General | Alele | Peak Detector | peak Quality | Quality Flags
Peak Detection Algorithem: |&dvanced -
Ranges Peak Detection
_ N Perform
in:I;SIS iﬁl;g Peak Amplituds Thresholds: internal
ool . B: |0 R: | 50 validation
G |50 o | 50 studies to
determine
G - settings
—Stmoothing and Baselining
Min. Peak Half vidth: 2 pts
Sroathing ) Mome ) 3
@ Light Polynomisl Degree:
() Heawy Peak Window Size: 15 pts
Bazeline Window: a1 pts Sz M
Peak Start: 0o
—Size Calling Method Pask End: oo

() Local Southern Methad
() Global Southern Methad

Factory Defaults

IMPORTANT! Perform the appropriate internal validation studies to determine the
peak amplitude thresholds for interpretation of data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID Software displays peaks that fall below the specified amplitude
in electropherograms, the software does not label or determine the genotype of
these peaks.

* Size calling method — This kit has been validated using the Local Southern sizing
method. Before using alternative sizing methods, perform the appropriate
internal validation studies.
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Peak Quality tab

. Analysis Method Editor 3]
settings — E————————
| General | allele | Peak Detector | Peak Quality | sq & G0 Settings |
ﬂnﬂ\ﬂax Peak Height (LPH/MPH) Perform
Homozygaus min peak height internal
validation
Heterozygaous min peak height .
¥ P ? studies to
\Max Peak Height (MPH) determine
settings
Peak Height Ratio (PHR)
Min peak height ratio

Broad Peak (ED)
Max peak width (basepairs)

allele Mumber (AR)

)
()
>
()
=
[
O
O
g
<)
)
w
o
=
=
(V)
=
()

Max expected alleles

allelic Ladder Spike

Spike Detection

&)

S ET LI

Cuk-off Walue

Factory Defaults

[ Save s ” Save ” Cancel H Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds and the
minimum peak height ratio threshold that allow for reliable interpretation of data.
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Quality Flags tab

! Analysis Method Editor - HID 3
settings

General | Allele || Peak Detector | Peak Guality | Qualty Flags |

Cuality weights are between Dand 1.
Ewality Flag Sefting

Spectral Pull-up 048 Control Concordance 1.0
Broad Peak 0a Lowy Peak Height [Bes
Out of Bin Allels Off-zcale 0a
Overlap Pesk Height Ratio 03

rPa Thresholc

Pazs Range: Low Guality Range:

Sizing Guslty: Fratn 101.0 From 0.0 t0
Ganatype Guality: From | 075 ta1.0 From 0.0 to

Factory Defaults

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform the appropriate internal validation studies
to determine the appropriate values to use in your laboratory.
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Create a size The GeneScan'" 600 LIZ® Size Standard v2.0 contains the following size standard
standard peaks:

GeneScan™ 600 LIZ® Size Standard v2.0 peak sizes

60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 220, 240, 250, 260, 280, 300, 314, 320, 340, 360,
380, 400, 414, 420, 440 and 460

To create the size standard definition file:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

# GeneMapper® ID-X Manager

Find Marme Cantaining: ‘| |

)
()
>
()
=
[
O
O
g
<)
)
w
o
=
=
(V)
=
()

| Projects | Analysis Methods | Table Settings | Plot Settings | Matricesl Size Standards | Report Settings |
|Name |Last Saved |Owner |T\,f|:e |Descripti0n
CE_F_HID_GS500 (75-900) 2007-08-09 13:23:E | gridx Advanced :
CE_F_HID_GS500 (75-4950) Z007-08-09 13:24:€ | groidx Advanced
CE_G5_HID_G3500 2011-04-18 13:15:¢ | gmidsx Advanced ]

2. Select the Size Standards tab, then click New.

3. Enter a name as shown below or enter a name of your choosing. In the Size
Standard Dye field, select Orange. In the Size Standard Table, enter the sizes
specified above.

(7] Size Standard Editor

Edit
~Size Standard Description
Marme: CE_G5_MGMSElectExpress GE600v2 |
Description;
Size Standard Dye: COrange b
rSize Standard Table

1 (800 -

2 1000

3 |1140

4 1200 1

5 1400

g [160.0

7 (1800

& (2000

9 (2140

~
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Analyze and edit sample files with GeneMapper® ID Software

44

1.

2.

In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above. If you named the settings
differently, select the names you specified.

Parameter Settings
Sample Type Select the sample type.
Analysis Method MiniFiler_AnalysisMethod_v1 (or the name of the analysis method you
created)
Panel MiniFiler_GS500_v1
Size Standard CE_G5_HID_GS500 (or the name of the size standard you created)

For more information about how the Size Caller works, refer to the GeneScan®
Analysis Software for the Windows NT® Operating System Overview of the Analysis
Parameters and Size Caller User Bulletin (Part no. 4335617). For additional
information about size standards, refer to the GeneMapper® ID Software Version 3.1
Human Identification Analysis User Guide (Part no. 4338775).

Click = (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis. During analysis:
¢ The status bar displays the progress of analysis as both:

— A completion bar extending to the right with the percentage completed
indicated

— Text messages on the left

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Genotypes tab becomes available after analysis.
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The following figure shows the analysis summary window after analysis.

GeneMapper ID v3.2.1 - *Untitled - gmid Is Logged In

File Edit Analysis ‘iew Tools Help

HEHH EE O OlN £l B @ Teble Setting |AmpFLSTR Table v | EH B =

(= =IProject Samples |M|

[StiniFier Exarnple Statuz |Sample File Sample Type | Analysis Method Panel |Size Standard Instrument
1 h Allelic Ladder fza |Allelic Ladder  |MiniFiler_AnalysisMetho \MiniFiler _GS500_w1 | Hi
2 !B'. Sample 1 fsa Sample MiriFiler_aAnalysishetho [MiniFiler_G5500_w1
3 !’W Sample 10.4sa Sample MiniFiler_Analysishetho |MiniFiler_GZ500_w1
4 !B'. Sarmple 11 fsa Satnple MiriFiler _analysishetho [MiniFiler_G5500_w1
5 h Sample 12.4sa Sample MiniFiler_AnalysisMetho |MiniFiler_GZ500_w1
5] !,,q Sarmple 13.fsa Satnple MiriFiler _analysisMetho [MiniFiler _G5500_w1
7 h Sample 14.1sa Sample MiniFiler_AnalysisMetho |MiniFiler_GZ500_w1
g !1,; Sample 15.1sa Sample MiniFiler _analysishetho [MiniFiler _GS500_w1
g h Sample 16.fza Sample MiniFiler_Analysishetho [MiniFiler_52500_w1
10 !1,; Sample 17 fza Sample IiniFiler_Analysishetho MiniFiler 3500 _w1
11 l’*{ Sample 18.fsa Positive Control |MiniFiler _AnalysisMetho |MiniFiler _GS500_w1
12 !1,; Sample 19.1sa Megative Contre |MiniFiler_&nalysizhethao |MiniFiler_GS500_v
13 l’*{ Sample 2 fsa Sample MiriFiler_aAnalysishetho [MiniFiler_G5500_w1
14 h Sample 3138 Sample MiniFiler_Analysishetho |MiniFiler_GZ500_w1
15 !B'. Sample 4 1sa Sample MiriFiler_aAnalysishetho [MiniFiler_G5500_w1
16 !’W Sample 3135 Sample MiniFiler_Analysishetho |MiniFiler_GZ500_w1
17 !B'. Sarmple 6138 Satnple MiriFiler _analysishetho [MiniFiler_G5500_w1
18 !’W Sample 7 fsa Sample MiniFiler_Analysishetho |MiniFiler_GZ500_w1
19 !B'. Sarmple 8138 Satnple MiriFiler _analysishetho [MiniFiler_G5500_w1
20 h Sample 9.13a Sample MiniFiler_AnalysisMetho |MiniFiler_GZ500_w1
< | >
JProaress Status ... 0% Stop

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).

For more information

For details about GeneMapper® ID Software features, allele filters, peak detection
algorithms, and project editing, refer to:

*  GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial
(Part no. 4335523)

o GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide (Part
no. 4338775)

e Installation Procedures and New Features for GeneMapper® ID Software Software
Version v3.2 User Bulletin (Part no. 4352543)
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Chapter 4 GeneMapper® ID-X Software

Overview of GeneMapper® ID-X Software

Section 4.2 GeneMapper® ID-X Software

Overview of GeneMapper® ID-X Software

GeneMapper® ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample
in a .fsa or .hid file. Using GeneMapper® ID-X Software v1.0.1 or higher you can then
analyze and interpret the data from the .fsa or .hid files.

Instruments Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.
Before you start When using GeneMapper® ID-X Software v1.0.1 or higher to perform human

identification (HID) analysis with AmpF(STR® kits, be aware that:

46

HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.
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Set up GeneMapper® ID-X Software for data analysis

Panel, bin, and The file names shown in this section may differ from the file names you see when you

stutter file version  download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com/support » Software, Patches & Updates » GeneMapper®
ID-X Software.

The instructions and examples in this section refer to the latest version of panel, bin,
and stutter file available at the time of publication.

Before using the Before you use GeneMapper® ID-X Software (v1.0.1 or higher for .fsa files, v1.2 or
software for the higher for .hid files) to analyze data for the first time, you must do the following:
first time 1. Check the version of panel, bin, and stutter files installed with the GeneMapper®

ID-X Software as explained in “Check panel, bin, and stutter file version” below.

o
o)
>
o
<
Q
o
B
@
@
>
x
w
o)
=
3
2
)

2. Check www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software to determine if newer files are available.

3. If updated files are available, download and import the files into the
GeneMapper® ID-X Software, as explained in “Import panels, bins, and marker
stutter” on page 48.

Note: When downloading new versions of analysis files, refer to the associated
Read Me file for details of changes between software file versions. If you have
validated previous file versions for data analysis, conduct the appropriate
internal verification studies before using new file versions for operational
analysis.

4. Create an analysis method, as explained in “Create an analysis method” on
page 53.

5. Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub. no. 4375574) for more information.

6. Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting Started
Guide (Pub. no. 4375574) for more information.

Check panel, bin, 1. Start the GeneMapper® ID-X Software, then log in with the appropriate user
and stutter file name and password.
version

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub. no. 4375574).

2. Select Tools » Panel Manager.
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3. Check the version of files imported into the Panel Manager:

'_5_..' Panel Manager

a. Select Panel Manager in the navigation pane. 75 = T o

b. Expand the Panel Manager folder and any sub- EHE
folders to identify the analysis file version already

i . X == Panel Manager
installed for your kit choice.

4. Check the version of files available for import into the
Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the Panels folder and check the version of panel, bin,
and stutter files installed.

5. If newer versions are available on the website, download and import as described

below.
Import pa nels, To import the MiniFiler™ Kit panel, bin set, and marker stutter from our web site into
bins, and marker the GeneMapper® ID-X Software database:

stutter 1. Download and open the file containing panels, bins, and marker stutter:

a. Go to www.lifetechnologies.com/support » Software, Patches &
Updates » GeneMapper® ID-X Software. Download the file AmpFLSTR
Analysis Files GMIDX.

b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub. no. 4375574).

3. Select Tools » Panel Manager.
4. Find, then open the folder containing the panels, bins, and marker stutter:
a. Select Panel Manager in the navigation pane.

(7] Panel Manager
File Edit Bins Wiew

=3 L BN L]

=5 Panel Manager

b. Select File » Import Panels to open the Import
Panels dialog box.

c. Navigate to, then open the AmpFLSTR Analysis
Files GMIDX folder that you unzipped in step 1
on page 48.
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5. Select AmpFLSTR_Panels_v2X (or the version you installed), then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager “AmpFLSTR_Panels_v2X”. This folder contains panels for multiple
AmpF(STR® kits and associated markers.

« Import Panels ®
Lookin: EAmpFLSTR Analysis Files GMIDK V| 53 ,_‘?'||EI

Y L] AmpFLSTR_Bins_vzx
{ 2) =

My Recent EIA - .
Documents | ] Reade_AmpFLSTR vz

Desktop

My Documents

(@)
(0]
=}
(0]
<
QO
©°
e}
SE
)]
S
<
wn
o
=3
=
D
(0]

g’ Flename:  |AmpFLSTR_Panels_vZi.bxt | [ mport |

My Computer | Files of bype: |,q|| Files v| Cancel

6. Import AmpFLSTR_Bins_v2X.txt:
a. Select the AmpFLSTR_Panels_v2X folder in the navigation pane.

« Panel Manager,
File Edit Bins View Help

WX (W E M W® |ense:|ampriseens_ v | i B B B EH BDEEEEEE

B...d%‘pand Manager Panel Hame Commment

[ AMpFLSTR_MGMSElect_vzy 1 [Cofler_wl.1x rull &

: gAmDFLSTR—NGM—VSX 2 |SEM_Plos_w1.1% il

AMpFLSTR_Panels_w1x

= = MGM_SElect_vz.1% Il

[ AmpFLS TR, Panels_vzy] 3 i n

4 |Identifiler_Plus_w1.1% rll

S |MGEM_v3.1% rll

& | Identifiler_Direct_w1.1%  |null

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
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d. Select AmpFLSTR_Bins_v2X.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AmpFLSTR_Panels_v2X folder.

« Import Bin Set ®
Lok in; E AMpFLSTR. Analysis Files GMIDR v | 5 ,,’:"|| =

i) AmpFLSTR Bins_vex |
L] ArmpFLSTR Panels_vzx
My Recenk QI AmpFLSTR_Stutker_wZx
Locuments | P ReadMe_AmpFLSTR_w2X

8 jie

Desktop

@

My Documents

File name: |&mpFLSTR_Bins_v2X.bxt | [ import |

My Computer | Files of bype: |p||| Files v| Cancel

7. View the imported panels in the navigation pane:
a. Double-click the AmpFLSTR_Panels_v2X folder.

b. Double-click the MiniFiler_v1.1X folder to display the panel information in
the right pane.

» Panel Manager
File Edit Bins ‘Wiew Help

' X O H O W™ enset:|amprstrEns_.. v | lii Ty Il B H HEBER

IE

(= gy Panel Manager Panel Hane Corronert.
) AMPFLSTR_MNGMSElect vz 1 Ofiler_wl,1% ndll
'%AWHSTR—NGM—”X 7 |SGM_Plos_v1.1% rul
) AMPFLSTR _Panels_w1X

- - MEM_SElect_wz2, 1% il
SR & AirpFL: 3 = -
[CCofiler vl 1% 4 |Identifiler_Plus_v1.13 il
[C)5GM_Plus_w1.1% 5 |NGM_v3. 1% ndll
ENGM—SE'B“—V& 1% & |ldenkifiler_Direct_v1.1%  |rul
Identifiler_Plus_wi. 1%

o Profiler_Plus_w1,1% il
[CIMEM_v3.1% 7 il
[C1dentifiler_Direct_w1.1¥ & |Profiler_v1.1x rull
[CProfiler_Plus_w1,1x o |SEfiler _Plus_w1.1% ndll
%Pmﬁ'er—“-lx 10 |Identifiler_v1.1% ]

SEfiler_Plus_w1.1%
oo MiniFiler_w1.1x il
[ Identifiler w1, 1% 1 -
- MiniFler_v1.1x 12 |Profiler_Plus_CODIS_v1.1|nul
W T Prefiler Pl CONTS Wl 1% 12 [vfiler w1 1% rll
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8. Select and expand MiniFiler_v1.1X in the navigation pane, then select D13S317 to
display the Bin view for the marker in the right pane.

»* Panel Manager

File Edit Bins View Help

B X | [ MM | B LY | Binser [amprisTR Bins_vax v faERE EEEEEENE e
-2 Identifiler_CODIS_v1.1X ~
(O Identifiler_Diract_v1.1% " 7 & ol hol Dby b2l sl s WS 4B
) Identifiler_Plus_v1,1x (@)
[C5 Identifiler_v1.13% 03 g
MiniFiler_v1.13¢ )
08 <
-D75820 =
. o7 o
- D251338 @
-D21511 B o &)
- D165539 S
-D18551 0.5 \
- CSF1PO
0.4 wn
: 3 5/ %
f' IE2 0z E
------ i Reference Samples V)
[iF] o

01

0.0
85 87 83 31 93 85 37 39 101 103105 107 103 111 113 115 117 119 121 123 125 127 129 131 133 135 137 139 141 143

0135317
< 1>
Marker: D135317 (590.00-139.00) |

[ QK H Cancel H Apply H Help ]

9. Import AmpFLSTR_Stutter_v2X:
a. Select the AmpFLSTR_Panels_v2X folder in the navigation panel.

« Panel Manager
File Edit Bins Yiew Help

a' > I OB ™ enset:|amprstr Bns_.. o | i T [ R EH  HEBI

i
B"'ﬁ%ﬁpamﬂ Manager Pangl Hame Contrnent
[C3AMpFLSTR_MGMSEleck w2y 1 Ofiler _w1,1% null =
EQWPF'—STR—NG""_\GX Z |5GM Plus_v1.1% nul
AmpFLSTR._Panels_w1x
i AmpFLS TR, Panel 3 |NGM_SElect_v2.1x nul
4 |Identifiler_Plus_w1.1% null

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog
box.

c. Navigate to, then open the AmpFLSTR Analysis Files GMIDX folder.
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d. Select AmpFLSTR_Stutter_v2X, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the AmpFLSTR_Panels_v2X folder.

« Import Marker, Stutter ®
Look in: E AmpFLSTR. Analysis Filss GMIDH v | 5 ,:J|| =

L AmpFLSTR_Bins _ves
L AmpFLSTR_Panels_va
My Recent B AmpFLSTR_Shutt 3
Documents —E] readie_ampFLSTR 2y

&

]
iy
.

-
IS
h=]

My Documents

%! File name: |AmpFLSTR_Stutter_v2:.txt | [ mport |

My Compuker | Files of bype: |.0.II Files v| Cancel

10. View the imported marker stutters in the navigation pane:

a. Double-click the AmpFLSTR_Panels_v2X folder to display its list of kits in
the right pane.

b. Double-click the MiniFiler_v1.1X folder to display its list of markers below
it.

c. Double-click D21511 to display the Stutter Ratio & Distance view for the
marker in the right pane.

#* Panel Manager
File Edit Bins View Help

EE O | @ M W W™ BinSet: | AmpFLSTR Bins_vax vV iLERE BEEEEER o
-IC3) Identifiler_CODIS_v1.1% - - :
E-{C3) dentifiler_Direct_v1.1X —|| Please enter the stutter filter(s) for D21511 marker here If left blank, the global stutter filter
-3 Identifiler_Plus_v1.1 willl be applied.
£ Identifiler_v1,1%
“MiniFiler_v1.1% c
it SEee Minus Stutter Plus Stutter
D75820 Ratic From Distance To Distance Ratic From Distance To Distance
1 1600 3.25 4.75 1
D21511 W s G
® Stukker Ratio & Distance 3 &
D165533 4 4
DigsoL < | & < | B
. @ CSFIPO v > 2 < 3
¢ | % [ New ] [ Edit ] [ Delete ]

------ i Reference Samples

11. Click Apply, then OK to add the MiniFiler™" Kit panel, bin set, and marker stutter
to the GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels,
bin sets, and marker stutter will not be imported into the GeneMapper® ID-X
Software database.
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Create an analysis  Use the following procedure to create an analysis method for the SGM Plus® Kit.
method

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created for
GeneMapper® ID-X version 1.2 is not compatible with earlier versions of
GeneMapper® ID-X Software or with GeneMapper® ID Software version 3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper® ID-X Manager.

 GeneMapper® ID-X Manager (%]

Find Mame Conkaining:

(@)
(0]
=}
(0]
<
Q
©
e)
o)
)
S
<
w
o
=3
s
L
(0]

Projects | Analysis Methods | Table Settings || Plaot Settings || Matrices | Size Standards | Report Settings

[ Mew... ][ Open... ][ Save As... ][ Import... ][ Export,..

2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.
The figures below show the settings for each tab of the Analysis Method Editor.
Configure the Analysis Method Editor tab settings as shown in the figures below,
unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

3. After you enter settings in all tabs, click Save.
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General tab

) Analysis Method Editor x|
settings =
General | Allele | Peak Detector | Pesk Quality | 5Q & GQ Settings |
rAnalysis Method Description
Mame: |MiniFiIer_ﬂ.naIysisMethod_\tE)d |
Security Group: |GeneMapper 1D-X Security Group v |
Description: A
v
Instrument:
Analysis Type: HID
[ Save ] [ Cancel ] [ Help ]

In the Name field, either type the name as shown or enter a name of your choosing. In
the Security Group field, select the Security Group appropriate to your software

configuration from the dropdown list. The Description and Instrument fields are
optional.
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Allele tab settings :
g Analysis Method Editor E|

| General | Allele | Peak Detector | Peak Quality | 55 & G0 Settings |

Bin Set: nn-.pFLETF:__E:ins

Use marker-specific stutter ratio and distance if available
Marker Repeat Type: Tri Tetra Penta Hexa
Global Cut-off Value 0.0 0.0 0.0 0.0
Minus4 R.atio 0.0 0.0 0.0 0.0
Minusa Distance From 0.0 0.0 0.0 0.0
To |0.0 0.0 0.0 0.0
Global Minus Stutker Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From (0.0 3.25 0.0 0.0
To (0.0 4.75 0.0 0.0
Global Plus Skukter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Distance From (0.0 0.0 0.0 0.0
To |0.0 0.0 0.0 0.0
Amelogenin Cukoff

Range Filter. .. Factory Defaulks

l Save ” Cancel ” Help l

¢ In the Bin Set field, select the AmpFLSTR_Bins_v2X bin set and configure the
stutter distance parameters as shown.

* GeneMapper® ID-X Software v1.0.1 or higher allows you to specify 4 types of
marker repeat motifs: tri, tetra, penta and hexa. You can enter parameter values
for each type of repeat in the appropriate column.

¢ Specify the stutter ratio:

— To apply the stutter ratios listed in the Allele tab for single-source data,
deselect the “Use marker-specific stutter ratio if available” check box
(selected by default). Perform appropriate internal validation studies to
determine the appropriate filter setting to use.

Note: Applying global stutter ratios may reduce the editing required for
single-source sample data.

— To apply the stutter ratios contained in the AmpFLSTR_Stutter_v2X file,
select the “Use marker-specific stutter ratio if available” check box (selected
by default). Perform appropriate internal validation studies to determine the
appropriate filter setting to use.
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Set up GeneMapper® ID-X Software for data analysis

Peak Detector tab
settings

56

Analysis Method Editor

General | allele | Peak Detector | Peak Quality | 5Q & GQ Settings

x]

Peak Detection Algorithm: Advanced

Ranges Peak Detection
Analysis Sizing Peak Amplitude Thresholds: Perform
Full Range v | | all Sizes v B | | i | | |nt§rngl
R validation
6 | | P | | studies to
- | | . | | determine
rSmoathing and Baselining————— > settings
Min. Peak Half width: |2 pts
Smoathing ) None
i : 3
) Light Paolynomial Degree
() Heawy Peak Window Size: 15 pts
Baseline Window: pts Slope Threshold
Peak Start: 0.0
rSize Calling Method Pesk End: 0.0

Marmalization

Use Mormalization, if applicable

(") Cubic Spline Interpalation
(") Lacal Southern Method
() Global Southern Method

’ Factory Defaults

[ Save ][ Cancel ][ Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
appropriate peak amplitude thresholds for interpretation of MiniFiler"" Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the

minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID-X Software displays peaks that fall below the specified
amplitude in electropherograms, the software does not label or determine the
genotype of these peaks.

Size calling method — The MiniFiler" Kit has been validated using the 3rd Order
Least Squares sizing method with the GeneScan" 500 LIZ® Size Standard. If you
use the GeneScan™ 600 LIZ® Size Standard v2.0, select the Local Southern
Method. Select alternative sizing methods only after performing the appropriate
internal validation studies.

Normalization — A Normalization checkbox is available on this tab in
GeneMapper® ID-X Software v1.2 for use in conjunction with data run on the
Applied Biosystems® 3500 Series Genetic Analyzers. Normalization cannot be
applied to 4-dye data, so this feature is not for use with MiniFiler"" Kit data.
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Set up GeneMapper® ID-X Software for data analysis

Peak Quality tab

. Analysis Method Editor, 3
settings - p— =

General | Alele PeakDetectan

ﬂnIMax Peak Height (LPHIMPH) \

Homozygous min peak height I:I Perform
Heterozygous min peak height I:I internal
validation
Max Peak Height {MPH) I:I studies to
determine
settings
Peak. Height Ratio (PHR)

Qﬂ peak height: ratio

Broad Peak (BDY

—
o

Max peak width (basepairs)
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Allele Mumber (AR

Max expected alleles

I

Allelic Ladder Spike

Cut-off Yalue 0.z

[ Factory Defaults

[ Save H Cancel H Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
minimum heterozygous and homozygous minimum peak height thresholds,
maximum peak height threshold and the minimum peak height ratio threshold for
interpretation of MiniFiler" Kit data.
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Set up GeneMapper® ID-X Software for data analysis

SQ & GQ tab Analysis Method Ed (x]
. nalysis Metho itor
settings = —
General | Allele | Peak Detector | Peak Quality || =
Cuality weights are between 0 and 1,
rSample and Control GO Weighting
Broad Peak (BL) 0.5 Allele Mumber (AR 1.0
Qut af Bin Allele (BIN) 0.5 Low Peak Height (LPH) 0.3
Overlap (VL) 0.5 Max Peak Height (MPH) 0.3
Marker Spike [SPK) 0.3 Off-scale (05) 0.5
Peak. Height Ratio (PHR) 0.3
Contral Concordance (ZC) Weight = 1.0 (Only applicable ko contrals)
30 weighting
Broad Peak (BD) 0.5
rallelic Ladder G0 weighting
Spike (SSPKISPK) 1 v Off-scale (05) 1w
S0 & G0 Ranges
Pass Range: | Low Qualty Range:
Sizing Ciuality: From | 0.75 to 1.0 FromO.0ko | 025
Genobype Guality:  From | 0.73 to 1.0 FromO.0ko | 025
[ Save As ] [ Save ] [ Zancel ] [ Help ]
IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to
determine the appropriate values to use.
Create size The CE_G5_GS500 (75-450) size standard definition is installed with the software for

standard (optional)

58

use with the MiniFiler™ Kit and contains

the following size standard peaks:

GeneScan™ 500 LIZ® Size Standard peak
sizes

GeneScan™ 600 LIZ® Size Standard v2.0
peak sizes

75,100, 139, 150, 160, 200, 300, 350, 400, and
450

80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
240, 250, 260, 280, 300, 314, 320, 340, 360,
380, 400, 414, 420, 440 and 460

Note: The 250-nt and the 340-nt peaks in the GeneScan"" 500 LIZ® Size Standard are
not included in the size standard definition. These peaks can be used as an indicator of

precision within a run.

Use the following procedure if you want to create your own size standard:

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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2. Select the Size Standards tab, then click New.

Find Mame Containing: ‘

| Projects | Analysis Methods | Table Settings | Plat Settings | Matrices| Size Standards | Repart Settings |

Qpen... Save As... Expork. .. Delete
3. Enter a name. In the Size Standard Dye field, select Orange. In the Size Standard

Table, enter the sizes specified in on page 58. The example below is for the
GeneScan'" 500 LIZ® Size Standard.

Marne Last Saved Cwner Type Description (0)

| CE_F_HID_GS500 (75-400) 2007-05-09 13:23:5 | gmidx Advanced g
| CE_F_HID_G5500 (75-450) 2007-05-09 13:24:0 | gmidx Advanced %
| CE_G5_HID_GS500 2006-10-11 13:12:% | gmids Advanced %
| GS600_LIZ 2007-06-26 10:43:1|grid:x Advanced -8
| GS600_LIZ+Mormalization_{80-400% |2007-06-27 01:43:1|gmid:x Advanced _‘®
| ES600_LIZ_(R0-400) 2007-06-27 01:43:1|gmidx Advanced 5

1

>

wn

o

=k

2

)

()

ot Size Standard Editor
Edit

rSize Standard Description

Mame: MiniFiler_GS500

Security Group:

Description:

Size Standard Dye: |Orange w |

rSize Standard Table

Size in Basepairs -
. [ tmsert ] [ Delete ]

2 (1000

3 |139.0

4 |150.0

5 |160.0

6 |200.0

7 |300.0

8 |340.0

9 |350.0

10 (400.0

11 (450.0

[ QK H Cancel H Help ]
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Analyze and edit sample files with GeneMapper® ID-X Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method MiniFiler_AnalysisMethod_v2X (or the name of the analysis
method you created)
Panel AmpFLSTR_Panels_v2X
Size Standard CE_G5_HID_GS500 (or the name of the size standard you
created)

Note: For more information about how the Size Caller works, refer to the
GeneScan™ Analysis Software for the Windows® NT Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617).
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Examine and edit a project

3. Click ® (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

* The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Analysis Summary tab is displayed and the Genotypes tab becomes
available upon completion of the analysis.

Analysis summary window after analysis

»* GeneMapper® ID-X - MiniFiler Example - gmidx Is Logged In Database GEBOLDROYNJO9E
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File Edit Analysis View Tools Admin Help
5 H % =g i) [ @ | TableSetting: | |3130(Data Analysis v | 2 & [ B e
B---%Project N Samples | Analysis Summary | Genotypes
- ICMiniFiler Example ’I—I | | =
Analysis Summary —
Select run Folder to display:
Sample Status [ Total # of Samples ]
[E Unanalyzed 1]
Analyzed 53
lgj Analysis Setting Changed 1]
Click a link below to display a filtered Samples Table containing only the samples selected.
Allelic Ladder Quality per run folder (based on SQ and CGQ only)
Run Folder [ Total # of Analyzed Ladders [ [ F [ C]
MiniFiler Example 4 4 0 0 |
Control Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, SQ, CGQ)
[ Contral Type [ Total # of Samples [ All thresholds met [ 0 One or more thresholds not met
Pasitive Contral 0 0 0
Custom Contral 0 0 0
Megative Control 2 2 1]
Tatal 2 2 1]
Sample Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, S0, CGQ)
[ [ Taotal # of Samples [ All threshalds met: [ 0 One or more threshalds nat met: ]
Samples 47 41 [ | 8
A
< ¥
Analysis Completed. I Stop |

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).
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For more information

For more information

For more information, refer to:
o GeneMapper® ID-X Software Version 1.0 Getting Started Guide (Pub. no. 4375574)
o GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (Pub. no. 4375670)
o GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub. no. 4375671)

o GeneMapper® ID-X Software Version 1.1(Mixture Analysis) Getting Started Guide
(Pub. no. 4396773)

o GeneMapper® ID-X Software Version 1.2 Reference Guide (Pub. no. 4426481)
o GeneMapper® ID-X Software Version 1.2 Quick Reference Guide (Pub. no. 4426482)
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Section 5.1

Overview

Experiments using
the MiniFiler™ Kit

Importance of
validation

Experiment
conditions

Section 5.1 Developmental Validation

Overview

Developmental Validation

This chapter provides results of the developmental validation experiments we
performed using the AmpF/(STR® MiniFiler™ PCR Amplification Kit.

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics. By
challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations that
are critical for sound data interpretation in casework (Sparkes, Kimpton, Watson et al.,
1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin et al., 1998).

The experiments to evaluate the performance of the MiniFiler" Kit were performed
according to the DNA Advisory Board (DAB) Quality Assurance Standards, effective
October 1, 1998 (DNA Advisory Board, 1998). The DAB standards describe the quality
assurance requirements that a laboratory should follow to ensure the quality and
integrity of the data and competency of the laboratory.

We performed additional experiments according to the revised guidelines from the
Scientific Working Group on DNA Analysis Methods (SWGDAM, July 10, 2003). Based
on these guidelines, we conducted experiments that comply with guidelines 1.0 and
2.0 and its associated subsections. This DNA methodology is not novel. (Moretti ef al.,
2001; Frank et al., 2001; Wallin et al., 2002; and Holt et al., 2000)

This chapter discusses many of the experiments we performed and provides examples
of results obtained. We chose conditions that produced optimum PCR product yield
and that met reproducible performance standards. It is our opinion that while these
experiments are not exhaustive, they are appropriate for a manufacturer of STR kits
intended for forensic and/or parentage testing use.

IMPORTANT! Each laboratory using the MiniFiler"" Kit must perform internal
validation studies.

Developmental validation

SWGDAM guideline
1.2.1

SWGDAM guideline
2.10.1

“Developmental validation is the demonstration of the accuracy, precision, and
reproducibility of a procedure by the manufacturer, technical organization, academic
institution, government laboratory, or other party.” (SWGDAM, July 2003)

“The reaction conditions needed to provide the required degree of specificity and
robustness must be determined. These include thermocycling parameters, the
concentration of primers, magnesium chloride, DNA polymerase, and other critical
reagents.” (SWGDAM, July 2003)
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Chapter 5 Experiments and Results

Developmental validation

PCR components We examined the concentration of each component of the MiniFiler™ Kit and
established that the concentration of each component was within the range where data
indicated that the amplification met the required performance criteria for specificity,
sensitivity, and reproducibility. For example, various magnesium chloride
concentrations were tested on the Applied Biosystems® 3130x/ Genetic Analyzer. The
amplification of 0.50 ng of the control DNA 007 is shown in Figure 4 on page 66. We
observed that the performance of the multiplex is most robust within a + 20% window
of magnesium chloride.

For example, blood and buccal samples on treated paper substrates or swab sample
lysates were amplified in the presence of varying concentrations of magnesium
chloride, and the results were analyzed on an Applied Biosystems® 3130x/ or 3500xL
Genetic Analyzer. Results are shown in Figure 4. The performance of the multiplex is
robust within +20% of the optimal magnesium chloride concentration.

Figure 4 A 0.50 ng sample of Contol DNA 007 amplified with the MiniFiler™ Kit in the presence of varying concentrations of
magnesium chloride and analyzed on an Applied Biosystems® 3130xl Genetic Analyzer (y-axis 5000 RFU).
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Thermal cycler Thermal cycling parameters were established for amplification of the MiniFiler™ Kit.
parameters Thermal cycling times and temperatures of GeneAmp® PCR systems were verified.

Varying annealing and denaturation temperature windows were tested to verify that a
specific PCR product with the desired sensitivity of at least 0.50 ng of Control
DNA 007 was produced.

For example, annealing temperatures of 55, 57, 59, 61, and 63°C were tested for two-
minute hold times in the Silver 96-Well GeneAmp® PCR System 9700 (Figure 5). The
PCR products were analyzed using an Applied Biosystems® 3130x! Genetic Analyzer.
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Developmental validation

Of the tested annealing temperatures, 55 to 61°C produced robust profiles. At 63°C the
yield of the majority loci was significantly reduced. No preferential amplification was
observed at the standard annealing temperature of 59°C. Thermal cycler temperature

is critical to assay performance; therefore, routine, regularly scheduled thermal cycler
calibration is strongly recommended.

Figure 5 Electropherograms obtained from amplification of 0.50 ng of Control DNA 007 at annealing temperatures of 55, 57,
59, 61, and 63°C, analyzed on an Applied Biosystems® 3130x/ Genetic Analyzer (y-axis 4000 RFU).
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PCR cycle number MiniFiler™ Kit reactions were amplified for 28, 29, 30, 31 and 32 cycles on the Silver 96-
Well GeneAmp® PCR System 9700 using 0.50 ng from three DNA samples. As
expected, the amount of PCR product increased with the number of cycles. A full
profile was generated 28 cycles and off-scale data were collected for several allele
peaks at 32 cycles (Figure 6).

While none of the cycle numbers tested produced nonspecific peaks, 30 cycles was
found to give optimal sensitivity when the amplified products were examined on
Applied Biosystems® 3130x! Genetic Analyzers.
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Figure 6 Representative

Accuracy, precision,

Chapter 5 Experiments and Results

and reproducibility

MiniFiler™ Kit profiles obtained from amplification of 0.50 ng DNA template using 28, 29, 30, 31,

and 32 cycles, analyzed on an Applied Biosystems® 3130x!{ Genetic Analyzer (y-axis 4000 RFU)
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Accuracy, precision, and reproducibility

SWGDAM guideline
2.9

Accuracy

68

“The extent to which a given set of measurements of the same sample agree with their
mean and the extent to which these measurements match the actual values being
measured should be determined.” (SWGDAM, July 2003)

Laser-induced fluorescence detection of length polymorphism at short tandem repeat
loci is not a novel methodology (Holt et al., 2000; and Wallin et al., 2002). However,
accuracy and reproducibility of MiniFiler™" Kit profiles have been determined from
various sample types. Figure 7 shows the size differences that are typically observed
between sample alleles and allelic ladder alleles on the Applied Biosystems® 3130x!
Genetic Analyzer with POP-4® polymer. The x axis in Figure 7 represents the nominal
nucleotide sizes for the AmpF(STR® MiniFiler™" Allelic Ladder. The dashed lines
parallel to the x axis represent +0.25-nt windows. The y axis represents the deviation of
each sample allele size from the corresponding Allelic Ladder allele size. All sample
alleles are within +0.5 nt from a corresponding allele in the Allelic Ladder.
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Figure 7 Allele Size vs. Allelic Ladder Sizing for 42 samples analyzed on an Applied Biosystems® 3130x( Genetic Analyzer
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Precision and size
windows

Sizing precision enables the determination of accurate and reliable genotypes. Sizing
precision was measured on an Applied Biosystems® 3130x! Genetic Analyzer. The
recommended method for genotyping is to employ a +0.5-nt “window” around the
size obtained for each allele in the AmpF(STR® MiniFiler™ Allelic Ladder. A +0.5-nt
window allows for the detection and correct assignment of alleles. Any sample allele
that sizes outside the specified window could be:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the
AmpF(STR® MiniFiler™ Allelic Ladder

or

* An allele that does correspond to an Allelic Ladder allele, but whose size is just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections on a capillary instrument.

Table 3 on page 70 shows typical precision results obtained from five runs

(16 capillaries/run) of the AmpF/STR® MiniFiler Allelic Ladder on an Applied
Biosystems® 3130x/ Genetic Analyzer (36-cm capillary and POP-4® polymer), using
the GeneScan'" 500 LIZ® Size Standard. The results were obtained within a set of
injections on a single capillary array.

Sample alleles may occasionally size outside of the +0.5-nt window for a respective
Allelic Ladder allele because of measurement error. The frequency of such an
occurrence is lowest in detection systems having the smallest standard deviations in
sizing. Figure 7 on page 69 illustrates the tight clustering of allele sizes obtained on the
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Applied Biosystems® 3130x! Genetic Analyzer, where the standard deviation in sizing
is typically less than 0.15 nt. The instance of a sample allele sizing outside the +0.5-nt
window because of measurement error is relatively rare when the standard deviation
in sizing is approximately 0.15 nt or less (Smith, 1995).

For sample alleles that do not size within a +0.5-nt window, the PCR product must be
rerun to distinguish between a true off-ladder allele versus measurement error of a
sample allele that corresponds with an allele in the Allelic Ladder. Repeat analysis,
when necessary, provides an added level of confidence in the final allele assignment.

GeneMapper® ID Software and GeneMapper® ID-X Software automatically flag
sample alleles that do not size within the prescribed window around an allelic ladder
allele by labelling the allele as OL (off-ladder).

Maximum sizing precision is obtained within the same set of capillary injections.
Cross-platform sizing differences occur due to a number of factors including type and
concentration of polymer, run temperature, and electrophoresis conditions. Variations
in sizing can also occur between runs on the same instrument and between runs on
different instruments of the same platform type because of these factors.

We strongly recommend that the allele sizes be compared to the sizes obtained for
known alleles in the AmpF(STR® MiniFiler™ Allelic Ladder from the same run and
then be converted to genotypes as described in “Before you start” on page 33
(GeneMapper® ID Software) and “Before you start” on page 46 (GeneMapper® ID-X
Software). See Table 3 for the results of five runs of the AmpF(STR® MiniFiler™ Allelic
Ladder on an Applied Biosystems® 3130x! Genetic Analyzer. For more information on
precision and genotyping, see Lazaruk ef al., 1998 and Mansfield et al., 1998.

In Table 3, the mean sizes for all the alleles in each run (16 capillaries) were calculated.
The mean range shown in the table represents the lowest and highest mean size values
obtained across all five runs. Similarly, the standard deviation for the allele sizing was
calculated for all the alleles in each run. The standard deviation range shown in Table 3
represents the lowest and highest standard deviation values obtained across all five
runs.

Table 3 Precision results of five runs (16 capillaries/run) of the AmpF{(STR® MiniFiler™ Allelic
Ladder

Allele Mean Standard Deviation
AMEL
X 101.54-101.59 0.024-0.037
Y 107.51-107.56 0.029-0.038
CSF1PO
6 86.65-86.67 0.027-0.038
7 90.70-90.72 0.026-0.038
8 94.72-94.77 0.023-0.036
9 98.76-98.79 0.033-0.041
10 102.79-102.81 ' 0.028-0.038
11 106.80-106.85 ' 0.031-0.044
12 110.82-110.85 0.030-0.043
13 114.83-114.88 0.027-0.045
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Allele Mean Standard Deviation
14 118.83-118.87 0.023-0.041
15 122.83-122.89 0.031-0.041

D13S317
8 103.25-103.28 0.029-0.039
9 107.38-107.43 0.028-0.042
10 111.50-111.54 0.035-0.044
" 115.63-115.66 0.031-0.045
12 119.73-119.78 0.037-0.044
13 123.82-123.85 0.038-0.047
14 127.83-127.88 0.038-0.049
15 131.93-131.97 0.035-0.051
D165539
5 74.96-75.01 0.033-0.047
8 87.58-87.61 0.030-0.044
9 91.78-91.81 0.021-0.039
10 95.91-95.95 0.038-0.046
" 100.06-100.09 0.038-0.046
12 104.20-104.22 0.041-0.045
13 108.30-108.36 0.031-0.044
14 112.42-112.46 0.037-0.050
15 116.52-116.58 0.037-0.048
D18S51
7 124.68-124.73 0.035-0.060
9 132.53-132.57 0.044-0.059
10 136.46-136.50 0.040-0.056
10.2 138.37-138.42 0.040-0.056
" 140.38-140.43 0.038-0.055
12 144.33-144.37 0.039-0.059
13 148.27-148.31 0.048-0.054
13.2 150.19-150.22 0.040-0.062
14 152.21-152.24 0.043-0.057
14.2 154.14-154.18 0.035-0.054
15 156.17-156.20 0.042-0.061
16 160.13-160.16 0.047-0.060
17 164.06-164.10 0.046-0.057
18 168.05-168.06 0.039-0.058
19 172.00-172.02 0.041-0.054
20 175.97-175.99 0.035-0.061
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Allele Mean Standard Deviation
21 179.93-179.96 0.045-0.055
22 183.92-183.95 0.048-0.064
23 187.89-187.94 0.043-0.062
24 191.87-191.91 0.045-0.058

D18S51
7 124.68-124.73 0.035-0.060
9 132.53-132.57 0.044-0.059
10 136.46-136.50 0.040-0.056
10.2 138.37-138.42 0.040-0.056
" 140.38-140.43 0.038-0.055
12 144.33-144.37 0.039-0.059
13 148.27-148.31 0.048-0.054
13.2 150.19-150.22 0.040-0.062
14 152.21-152.24 0.043-0.057
14.2 154.14-154.18 0.035-0.054
15 156.17-156.20 0.042-0.061
16 160.13-160.16 0.047-0.060
17 164.06-164.10 0.046-0.057
18 168.05-168.06 0.039-0.058
19 172.00-172.02 0.041-0.054
20 175.97-175.99 0.035-0.061
21 179.93-179.96 0.045-0.055
22 183.92-183.95 0.048-0.064
23 187.89-187.94 0.043-0.062
24 191.87-191.91 0.045-0.058
25 195.85-195.87 0.053-0.070
26 199.86-199.89 0.047-0.063
27 203.84-203.88 0.044-0.070
D21S11

24 186.96-186.99 0.056-0.067
24.2 188.95-188.97 0.047-0.066
25 190.89-190.92 0.051-0.071
26 194.82-194.84 0.052-0.063
27 198.67-198.7 0.053-0.071
28 202.71-202.74 0.055-0.065
28.2 204.63-204.66 0.060-0.070
29 206.73-206.77 0.048-0.072
29.2 208.50-208.55 0.051-0.077
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Allele Mean Standard Deviation
30 210.59-210.63 0.053-0.075
30.2 212.53-212.59 0.058-0.067
31 214.54-214.59 0.054-0.069
31.2 216.51-216.55 0.054-0.075
32 218.48-218.55 0.051-0.067
32.2 220.48-220.53 0.057-0.073
33 222.46-222.51 0.055-0.073
33.2 224.52-224.57 0.052-0.078
34 226.35-226.39 0.054-0.063
34.2 228.42-228.47 0.049-0.072
35 230.35-230.40 0.047-0.081
35.2 232.38-232.45 0.055-0.083
36 234.42-234.48 0.053-0.080
37 238.31-238.36 0.057-0.074
38 242.61-242.47 0.063-0.077
D2S51338
15 120.06-120.10 0.032-0.042
16 124.11-124.16 0.028-0.044
17 128.07-128.12 0.031-0.044
18 132.04-132.08 0.036-0.051
19 136.05-136.08 0.028-0.046
20 140.00-140.04 0.028-0.045
21 144.01-144.04 0.034-0.043
22 147.99-148.02 0.029-0.039
23 151.96-151.99 0.034-0.044
24 155.95-155.97 0.029-0.042
25 159.93-159.94 0.038-0.049
26 163.91-163.94 0.032-0.055
27 167.99-168.01 0.033-0.052
28 172.24-172.26 0.038-0.052
D75820
6 149.69-149.73 0.032-0.051
7 153.65-153.68 0.036-0.051
8 157.62-157.65 0.031-0.051
9 161.59-161.62 0.032-0.057
10 165.55-165.57 0.035-0.046
" 169.53-169.54 0.037-0.050
12 173.50-173.52 0.034-0.055
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Accuracy, precision, and reproducibility

Allele Mean Standard Deviation
13 177.48-177.50 0.041-0.047
14 181.46-181.49 ' 0.034-0.050
15 185.45-185.47 0.034-0.053

FGA
17 150.52-150.55 0.031-0.040
18 154.26-154.29 0.031-0.043
19 158.03-158.04 ' 0.029-0.047
20 161.78-161.80 0.033-0.044
21 165.55-165.57 0.030-0.042
22 169.32-169.34 0.031-0.047
23 173.11-173.12 ' 0.032-0.041
24 176.88-176.91 0.034-0.048
25 180.68-180.70 0.025-0.045
26 184.49-184.51 0.031-0.047
26.2 186.29-186.34 ' 0.027-0.049
27 188.34-188.37 0.022-0.047
28 192.20-192.25 0.037-0.047
29 195.97-196.02 0.032-0.046
30 199.69-199.74 ' 0.032-0.047
30.2 202.12-202.17 0.034-0.055
31.2 205.94-205.98 0.034-0.055
32.2 209.74-209.80 0.034-0.051
33.2 213.57-213.64 ' 0.035-0.064
42.2 248.46-248.55 0.042-0.064
43.2 252.35-252.43 0.038-0.067
44.2 256.39-256.46 0.043-0.064
45.2 260.28-260.36 ' 0.043-0.054
46.2 263.89-263.95 0.040-0.055
47.2 267.71-267.77 0.039-0.057
48.2 271.69-271.76 0.040-0.058
50.2 279.48-279.54 ' 0.036-0.062
51.2 283.23-283.28 0.041-0.061
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Extra peaks in the electropherogram

Causes of extra Peaks other than the target alleles may be detected on the electropherogram. Causes

peaks for the appearance of extra peaks include stutter products, incomplete 3" A nucleotide
addition (at the n-1 position), dye artifacts, and mixed DNA samples (see DAB
Standard 8.1.2.2).

Stutter products

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller (or less frequently, one repeat larger) than the major STR
product (Butler, 2005; Mulero ef al., 2006). Sequence analysis of stutter products at
tetranucleotide STR loci has revealed that the stutter product is missing a single
tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996).
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The proportion of the stutter product relative to the main allele (stutter percent) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Peak heights were measured for amplified samples (n=967) at the loci used in the
MiniFiler™ Kit. All data were generated on the Applied Biosystems® 3130x! Genetic
Analyzer.

Some conclusions from these measurements and observations are:

* For each MiniFiler Kit locus, the stutter percentage generally increases with
allele length, as shown in Figure 8 on page 76 through Figure 11 on page 77.

* Smaller alleles display a lower level of stutter relative to the longer alleles within
each locus.

* Each allele within a locus displays a consistent stutter percentage.

* Stutter filter sets in GeneMapper® ID and GeneMapper® ID-X Software,
calculated as the mean stutter for the locus plus three standard deviations
(N = 668), are shown in Table 4 on page 78. Peaks in the stutter position that are
above the stutter filter percentage specified in the software are not filtered. Peaks
in the stutter position that have not been filtered and remain labeled can be
further evaluated.

* The measurement of stutter percentage for allele peaks that are off-scale may be
unusually high.

AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide 75



5 Chapter 5 Experiments and Results
Extra peaks in the electropherogram

Figure 8 Stutter percentages for D135317 and D75820 loci
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Figure 9 Stutter percentages for the D251338 and D21511 loci
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Figure 10 Stutter percentages for the D165539 and D18551 loci
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Figure 11 Stutter percentages for the CSF1PO and FGA loci
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Table 4 Marker-specific stutter filter percentages for MiniFiler™ Kit loci

Locust % Stutter
D13S317 14
D75820 1
D251338 18
D21511 16
D165539 15
D18S51 18
CSF1PO 14
FGA 15

t These percentages are used as stutter filters in GeneMapper® /D v3.2.1 AmpFLSTR_MiniFiler_Panels_v1.txt
and GeneMapper® ID-X AmpFLSTR_Stutter_v2X.

IMPORTANT! The values shown are the values we determined during developmental
validation studies. We recommend that laboratories perform internal validation
studies to determine the appropriate values to use.

Addition of 3" A nucleotide

Many DNA polymerases can catalyze the addition of a single nucleotide
(predominantly adenosine) to the 3" ends of double-stranded PCR products (Clark,
1988; Magnuson et al., 1996). This nontemplate addition results in a PCR product that
is one nucleotide longer than the actual target sequence. The PCR product with the
extra nucleotide is referred to as the “+A” form.

The efficiency of +A addition is related to the particular sequence of the DNA at the 3’
end of the PCR product. The MiniFiler" Kit includes two main design features that
promote maximum +A addition:

¢ The primer sequences have been optimized to encourage +A addition.
¢ The new, highly robust PCR chemistry allows complete +A addition with a short
final incubation at 60°C for 5 minutes.

This final extension step gives the DNA polymerase additional time to complete +A
addition to all double-stranded PCR products. STR systems, where each allele is
represented by two peaks one nucleotide apart, that have not been optimized for +A
addition may have “split peaks.”

Figure 12 shows examples of incomplete and normal +A addition.
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Figure 12 Omission of the final extension step resulted in split peaks due to incomplete A
nucleotide addition. These data were generated on the 310 Genetic Analyzer using another

AmpF(STR®kit.
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Lack of complete +A nucleotide addition may be observed in MiniFiler" Kit results
when the amount of input DNA is greater than the recommended protocols, because
more time is needed for the DNA Polymerase to add the +A nucleotide to all molecules
as more PCR product is generated. Amplification of too much input DNA may also
result in off-scale data.

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible while anomalies are non-reproducible, intermittent occurrences
that are not observed consistently in a system (for example, spikes and baseline noise).
Artifacts have been seen in data produced on genetic analyzers when using the
MiniFiler™ Kit. In amplified samples, artifacts in the non-calling region may appear in
the blue (70 nt) and VIC® (80 nt) dyes. Low-level artifacts in the calling region may
appear in the blue (117 and 127 nt), green (118 nt), and black (166 nt) dyes, depending
on the sensitivity of the instrument.
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Figure 13 shows examples of baseline noise and artifacts in an electropherogram while
using the MiniFiler"" Kit. You should consider possible noise and artifacts when
interpreting data from the MiniFiler" Kit on the Applied Biosystems® 3130x! Genetic
Analyzer.

Note: A high degree of magnification (y-axis) is used in Figure 13 to illustrate these
artifacts (data produced on capillary electrophoresis instrument platforms).

Figure 13 Examples of baseline noise and reproducible artifacts in data produced on an Applied
Biosystems® 3130x( Genetic Analyzer
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Another type of PCR artifact occurs when the amount of input DNA exceeds the
recommended amount (0.50 to 0.75 ng). These artifacts were characterized as
secondary stutter products in D135317 and D21S11 as shown in the bottom example in
Figure 13. Their mobility varies with that of the main amplification product.

Genotyping may result in the detection of these artifacts as off-ladder alleles, or “OL
Alleles”. This occurs if the recommended amount of input DNA is exceeded and
off-scale data is obtained.

Characterization of loci

SWGDAM guideline  “The basic characteristics of a genetic marker must be determined and documented.”
2.1 (SWGDAM,, July 2003)

This section describes basic characteristics of the eight loci and the sex-determining
marker, Amelogenin, which are amplified with the MiniFiler"" Kit. Most of these loci
have been extensively characterized by other laboratories.

Nature of the The primers for the Amelogenin locus flank a six-nucleotide deletion within intron 1 of

polymorphisms the X homologue. Amplification results in 104-nt and 110-nt products from the X and Y
chromosomes, respectively. (Sizes are the actual nucleotide size according to
sequencing results, including 3" A nucleotide addition.) The remaining MiniFiler ™ Kit
loci are all tetranucleotide short tandem repeat (STR) loci. The length differences
among alleles of a particular locus result from differences in the number of 4-nt repeat
units.

We have sequenced all the alleles in the AmpF(STR® MiniFiler™ Allelic Ladder. In
addition, other groups in the scientific community have sequenced alleles at some of
these loci. Among the various sources of sequence data on the MiniFiler'" Kit loci,
there is consensus on the repeat patterns and structure of the STRs.

Inheritance The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from
families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to characterize
the mode of inheritance of various DNA loci. Each family set contains three
generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al., 1992).

Three CEPH family DNA sets were examined. 0.50 ng of DNA from each sample was
amplified using the MiniFiler™ Kit and Identifiler® Kit, followed by analysis using an
Applied Biosystems® 3130x! Genetic Analyzer. The families examined included #1333
(9 offspring), #1340 (7 offspring), and #1345 (7 offspring), representing 23 meiotic
divisions. The results showed concordance between MiniFiler™ Kit and Identifiler®
Kit genotypes and confirmed that the loci are inherited according to Mendelian rules,
as expected.

Ma pping The MiniFiler™ Kit loci have been mapped, and the chromosomal locations have been
published (Nakahori ef al., 1991; Edwards et al., 1992; Kimpton ef al., 1992; Mills et al.,
1992; Sharma and Litt, 1992; Li et al., 1993; Straub et al., 1993; Barber and Parkin, 1996).

AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide 81

@)
@
<
o
9
o)
3
o)
>
=l
L
&
5
=
o
=)




Chapter 5 Experiments and Results

Species specificity

Species specificity

SWGDAM Guideline

2.2

“For techniques designed to type human DNA, the potential to detect DNA from
forensically relevant nonhuman species should be evaluated.” (SWGDAM, July 2003)

The MiniFiler™ Kit provides the required specificity for primates. Other species do not
amplify for the loci tested.

Nonhuman studies
The following species were tested (in the specified amounts) using standard PCR and
capillary electrophoresis conditions for the MiniFiler Kit.

* Primates: gorilla, chimpanzee, orangutan, and macaque (0.50 ng each)

* Non-primates: mouse, dog, pig, cat, horse, hamster, rat, chicken and cow
(10 ng each)

* Microorganisms: Candida alb icans, Escherichia coli, Lactob acillus casei, Staphylococcus
aureus, Neisseria gonorrhoeae, Bacillus sub tilis, and Lactob acillus rhamnosus
(equivalent to 10° copies).

The chimpanzee and gorilla DNA samples produced partial profiles within the
70 to 283 nucleotide region.

The remaining species tested did not yield reproducible detectable products.

Figure 14 on page 82 shows example electropherogram results from the species
specificity tests.

Figure 14 Representative electropherograms for some species tested in a species specificity study including positive and
non-template controls (NTC)
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Sensitivity

SWGDAM guideline  “When appropriate, the range of DNA quantities able to produce reliable typing

2.3 results should be determined.” (SWGDAM, July 2003)

Effect of DNA If too much DNA is added to the PCR reaction, the increased amount of PCR product

quantity on results that is generated can result in:

¢ Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data).
Off-scale data is a problem because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.
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— Multicomponent analysis of off-scale data is not accurate. This inaccuracy
results in poor spectral separation (“pull-up”).

¢ Incomplete +A nucleotide addition.
The sample can be re-amplified using less DNA.

When the total number of allele copies added to the PCR is extremely low, unbalanced
amplification of the alleles may occur because of stochastic fluctuation.

Individual laboratories may find it useful to determine an appropriate minimum peak
height threshold based on their own results and instruments using low amounts of
input DNA.

Figure 15 Effect of amplifying varying amounts of Control DNA 007
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Note that the y-axis scale is magnified for the lower amounts of DNA, analyzed using
the Applied Biosystems® 3130x! Genetic Analyzer.
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Stability

SWGDAM guideline
2.4

Degraded DNA

84

“The ability to obtain results from DNA recovered from biological samples deposited
on various substrates and subjected to various environmental and chemical insults has
been extensively documented. In most instances, assessment of the effects of these
factors on new forensic DNA procedures is not required. However, if substrates and/
or environmental and/or chemical insults could potentially affect the analytical
process, then the process should be evaluated using known samples to determine the
effects of such factors.” (SWGDAM, July 2003)

As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product generated is reduced, due to the reduced number of intact
templates in the size range necessary for amplification.

Degraded DNA was prepared to examine the potential for preferential amplification
of loci. High molecular weight Raji DNA was sonicated and incubated with increasing
doses of DNase I (0 to 6 Units) for 20 minutes (Bender et al., 2004). The DNA was
examined by capillary electrophoresis analysis to determine the average size of the
DNA fragments at each time point.

One nanogram of degraded DNA was amplified using the MiniFiler'" Kit and
Identifiler® Kit. Two nanograms of degraded DNA was amplified using the SGM
Plus® PCR Amplification Kit. As the DNA became increasingly degraded, the larger
size Identifiler® Kit and SGM Plus® Kit loci became undetectable. However, the
amplification with the MiniFiler"" Kit resulted in an increased overall typing success
rate.
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Figure 16 Amplification of Raji DNA samples untreated or sonicated for 5 minutes and
incubated with DNase |
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The performance of the three kits was compared in a simulated model of DNA
degradation (sonication and DNase I treatments). Only those loci (>50 RFUs)
represented in the MiniFiler"" Kit were measured in the Identifiler® Kit and SGM
Plus® Kit (see Table 5). A complete profile with Raji DNA yields 14 peaks using the
MiniFiler™ Kit.
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Table 5 Comparison of MiniFiler™, Identifiler®, and SGM Plus® Kit performance in simulated
model of DNA degradation (n = 3]

DNase | MiniFiler™ Kit Identifiler® Kit SGM Plus® kit
0 units 14/14, 14/14, 14/14 1414, 16/14, 14/14 10/10, 10/10, 10/10
4 units 14/14, 14/14, 14/14 8/14, 3/14, 4/14 2/10, 4/10, 5/10
5 units 1414, 14/14, 14/14 314, 4/14, 414 2/10, 2/10, 2/10
6 units 14/14, 14/14, 13/14 0/14, 0/14, 0/14 0/10, 1/10, 1/10

Heme compounds have been identified as PCR inhibitors in DNA samples extracted
from bloodstains (DeFranchis et al., 1988; Akane et al., 1994). It is believed that the
inhibitor is co-extracted and co-purified with the DNA and subsequently interferes
with PCR by inhibiting polymerase activity.

To examine the effects of hematin on the amplification results obtained by the
MiniFiler™ Kit, male Control DNA 007 (1 ng input DNA for the MiniFiler " Kit and the
Identifiler® Kit and 2 ng for the SGM Plus® Kit) was amplified with increasing
concentrations of hematin. The concentrations of hematin used were 0 uM, 20 pM,

40 uM, 60 uM, and 80 uM. No preferential amplification was observed in the presence
of increasing amounts of hematin (Figure 17 on page 87).
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Figure 17 Amplification of Control DNA 007 in the presence of hematin analyzed on the Applied
Biosystems® 3130x! Genetic Analyzer
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Comparison of performance of the three kits in a simulated model of hematin
inhibition. Only those loci (>50 RFU) represented in the MiniFiler" Kit were measured
in the Identifiler® Kit and SGM Plus® Kit (see Table 6). A complete profile with Control
DNA 007 yields 17 peaks using the MiniFiler™ Kit.
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Table 6 Comparison of MiniFiler™, Identifiler®, and SGM Plus® Kit performance in simulated
model of hematin inhibition (n = 3)

Hematin MiniFiler™ Kit Identifiler® Kit SGM Plus® kit
20 uM 17/17, 17/17, 17/17 17/17, 17/17, 17/17 14/14, 14/14, 14/14
40 uM 17/17, 17/17, 17/17 17/17, 17/17, 9/17 14/14, 14/14, 1414
60 uM 17/17, 1717, 17/17 2/17, 2/17, 0/17 2/14, 114, 2/14
80 uM 17/17, 17/17, 17/17 0/17, 0/17, 0/17 0/14, 0/14, 0/14

Effect of inhibitors Traces of humic acid may inhibit the PCR amplification of DNA evidence collected

- Humic Acid from soil. In this study, we tested increasing amounts of humic acid in the PCR
amplification of 1 ng of Control DNA 007 with the Identifiler® Kit and the MiniFiler™
Kit and 2 ng with the SGM Plus® Kit. As the concentration of humic acid increased in
the reaction, the larger Identifiler® Kit and SGM Plus® Kit loci failed to amplify.
However, the MiniFiler"" Kit loci efficiently amplified the DNA at concentrations of
humic acid that inhibited the amplification of DNA with the Identifiler® Kit and SGM
Plus® Kit (Figure 18 on page 89). The concentrations of humic acid tested were 0, 10,
30, and 50 ng/uL.
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Figure 18 Amplification of Control DNA 007 in the presence of humic acid analyzed on the
Applied Biosystems® 3130x( Genetic Analyzer
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Comparison of performance of the three kits in a simulated model of humic acid
inhibition. Only those loci (>50 RFU) represented in the MiniFiler" Kit were measured
in the Identifiler® Kit and SGM Plus® Kit (see Table 7). A complete profile with control
007 DNA yields 17 peaks using the MiniFiler™ Kit.
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Table 7 Comparison of MiniFiler™, Identifiler®, and SGM Plus® Kit performance in simulated
model of humic acid inhibition (n = 5)

Humic Acid MiniFiler™ Kit Identifiler® Kit SGM Plus® kit
10 ng/uL 17/17, 17/17, 17/17, 17/17, 17/17, 17/17, 14/14, 14/14, 14/14,
17/17, 17/17 17/17, 14/17 1414, 14/14
30 ng/uL 1717, 17/17, 17/17, 0/17, 0/17, 0/17, 0/ 0/14, 0/14, 0/14, O/
17/17, 17/17 17, 0/17 14, 0/14
50 ng/uL 17/17, 17/17, 17/17, 0/17, 0/17, 0/17, 0/ 0/14, 0/14, 0/14, O/

17/17, 14/17

17, 0/17

14, 0/14

Mixture studies

SWGDAM guideline
2.8

Mixture studies

90

“The ability to obtain reliable results from mixed source samples should be
determined.” (SWGDAM, July 2003)

Evidence samples may contain DNA from more than one individual. The possibility of
multiple contributors should be considered when interpreting the results. We
recommend that individual laboratories assign a minimum peak height threshold
based on validation experiments performed in each laboratory to avoid typing when
stochastic effects are likely to interfere with accurate interpretation of mixtures.

Evidence samples that contain body fluids and/or tissues originating from more than
one individual are an integral component of forensic casework. Therefore, it is
essential to ensure that the DNA typing system is able to detect DNA mixtures. Mixed
samples can be distinguished from single source samples in a variety of ways:

¢ The presence of greater than two alleles at a locus.

¢ The presence of a peak at a stutter position that is significantly greater in
percentage than what is typically observed in a single-source sample.

¢ Significantly imbalanced alleles for a heterozygous genotype.

The peak height ratio is defined as the height of the lower peak (in RFU) divided by the
height of the higher peak (in RFU), expressed as a percentage. Mean, median,
minimum, and maximum peak height ratios observed for alleles in the MiniFiler™ Kit
loci in unmixed population database samples are shown in Table 8.
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Table 8 Peak height ratios for 0.50 ng input DNA

Number of
Allele Observatio Mean Median Minimum Maximum
ns (n)
CSF1PO 781 87.9 89.3 57.9 100.0
D251338 911 87.0 88.8 52.3 100.0
D75820 820 88.1 89.7 58.4 100.0 g
D13s317 733 88.4 90.4 50.5 100.0 '§
D165539 804 87.5 89.1 46.1 100.0 %
D18S51 906 87.9 89.2 55.1 100.0 g
D21S11 856 88.2 90.0 471 100.0 %‘
FGA 904 88.0 89.4 53.9 100.0

If an unusually low peak height ratio is observed for one locus, and there are no other
indications that the sample is a mixture, the sample may be reamplified and
reanalyzed to determine if the imbalance is reproducible. Possible causes of imbalance
at a locus are:

* Degraded DNA

e Presence of inhibitors

¢ Extremely low amounts of input DNA
* SNP in one of the primer binding sites

* Presence of an allele containing a rare sequence that does not amplify as
efficiently as the other allele

Resolution of A sample containing DNA from two sources can be comprised (at a single locus) of
genotypes in mixed  any of the seven genotype combinations listed below.

samples * Heterozygote + heterozygote, no overlapping alleles (four peaks)
e Heterozygote + heterozygote, one overlapping allele (three peaks)
* Heterozygote + heterozygote, two overlapping alleles (two peaks)
* Heterozygote + homozygote, no overlapping alleles (three peaks)
* Heterozygote + homozygote, overlapping allele (two peaks)
* Homozygote + homozygote, no overlapping alleles (two peaks)
* Homozygote + homozygote, overlapping allele (one peak)
Specific genotype combinations and input DNA ratios of the samples contained in a

mixture determine whether it is possible to resolve the genotypes of the major and
minor component(s) at a single locus.

The ability to obtain and compare quantitative values for the different allele peak
heights on Life Technologies instruments provides additional valuable data to aid in
resolving mixed genotypes. This quantitative value is much less subjective than
comparing relative intensities of bands on a stained gel.
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Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case, including the information provided from

known reference sample(s).

Figure 19 Amplification of DNA mixtures at various ratios
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1:0

15:1

7:1

3:1

1:1

0:1

Mixtures of two DNA samples were examined at various ratios (0:1, 1:1, 3:1, 7:1, 15:1,
1:0). The total amount of genomic input DNA mixed at each ratio was 1 ng. The

samples were amplified in a GeneAmp® PCR System 9700 and were electrophoresed
and detected using an Life Technologies 3130x! Genetic analyzer.

The results of the mixed DNA samples are shown in Figure 19 above, where samples A
and B were mixed according to the ratios provided. The minor component allele calls

at non-overlapping loci are highlighted. The amplification of the minor contributor at

3:1 and 7:1 (0.875:0.125 ng) mixture ratios was readily typeable. 15:1 ratios generally

resulted in partial profiles for the minor component.

The profiles of the samples in Figure 19 are shown in Table 9.
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Table 9 Genotypes of mixed DNA samples

Allele [Z;‘:‘fti:ilsgz‘:fo‘;‘] Profile Sample B
D135317 11 12,14
D75820 7,12 8,9

Amelogenin XY XY
D251338 20, 23 20, 21 §
D21511 28, 31 28, 30 9
D165539 9,10 12,13 3
D18551 12,15 17,19 i’é
CSF1PO 1,12 10 5

FGA 24, 26 21,22 )

The MiniFiler kit has been optimized to amplify and type approximately 0.50 to
0.75 ng of single source DNA reliably.

Population data

SWGDAM guideline “The distribution of genetic markers in populations should be determined in relevant
2.7 population groups.” (SWGDAM, July 2003)

Overview To interpret the significance of a match between genetically typed samples, you must
know the population distribution of alleles at each locus in question. If the genotype of
the relevant evidence sample is:

¢ Different from the genotype of a suspects reference sample, then the suspect is
excluded as the donor of the biological evidence that was tested. An exclusion is
independent of the frequency of the two genotypes in the population.

* The same as the genotype of a suspects reference sample, then the suspect is
included as a possible source of the evidence sample.

The probability that another, unrelated individual would also match the evidence
sample is estimated by the frequency of that genotype in the relevant population(s).

The MiniFiler™ Kit contains loci for which extensive population data are available. For
additional information on 11 loci shared between many of the AmpF(STR® kits, see the
population data and additional studies section of the AmpF(STR® Identifiler® PCR
Amplification Kit User Guide (Part no. 4323291).

Analyzing the four databases

Analysis across the four databases of 2274 total chromosomes per locus revealed the
following number of different alleles: 10 CSF1PO alleles, 13 D251338 alleles, 9 D75820
alleles, 8 D135317 alleles, 8 D165539 alleles, 20 D18S51 alleles, 26 D21S11 alleles, and 31
FGA alleles.
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In addition to the alleles that were observed and recorded in the Life Technologies
databases, other alleles have been published or reported to us by other laboratories
(see the STRBase at www.cstl.nist.gov/div831/strbase).

Low-frequency alleles

Some alleles of the MiniFiler" Kit loci occur at a low frequency. For these alleles, a
minimum frequency (five divided by 2n, where n equals the number of individuals in
the database) was assigned for the MiniFiler™ Kit African-American, U.S. Caucasian,
U.S. Hispanic and Native American databases, as suggested in the 1996 report of the
Committee on DNA Forensic Science (National Research Council, 1996). These
databases are summarized in Chapter 5 of the AmpF(STR® Identifiler® PCR
Amplification Kit User Guide (Part no. 4323291). The minimum reportable genotype
frequency at each locus is as follows:.

e 1.19 x 10~# for the African-American database

e 1.19 x 107# for the U.S. Caucasian database

* 1.70 x 10~* for the U.S. Hispanic database; and

e 297 x 10~* for the Native American database
[p? + p(1-p) 6, where 6 = 0.01].

Therefore, the minimum combined multilocus genotype frequency at 8 loci is as
follows:

e 4.02x 10732 for the African-American database;
e 4.02 x 10732 for the U.S. Caucasian database;

* 6.98 x 10731 for the U.S. Hispanic database; and
e 6.05x 1072 for the Native American database

Primer relocation in the MiniFiler™ Kit could unintentionally lead to allele imbalance
or allele dropouts that are not found in the Identifiler® kit. These may be caused by a
SNP or a deletion in the primer binding site. Experimental data was used to quantitate
allele calling differences between the MiniFiler" Kit and the Identifiler® Kit.

We analyzed 1,064 samples (353 Caucasians, 347 African Americans, 207 Hispanics,
and 157 Asians) by comparing allele calls between the Identifiler® Kit and MiniFiler""
Kit. In the majority of samples analyzed, the results were found to be concordant
between the kits with minor discordancy found in few exceptions. Discordant data
were found in D135317 (1.73% in African Americans, 0.57% in Caucasians, and 1.45%
in Hispanics), D75820 (0.29% in African Americans), CSF1PO (0.48% in Hispanics),
D16S539 (1.73% in African Americans and 0.64% in Asians), and D18551 (0.48% in
Hispanics). The variants leading to discordant genotypes in the D135317 locus have
been characterized previously (Drabek, 2004).
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Mutation rate

Estimating germ- Estimation of spontaneous or induced germ-line mutation at genetic loci can be
line mutations achieved by comparing the genotypes of offspring to those of their parents. From such
comparisons the number of observed mutations are counted directly.

In previous studies, genotypes of ten STR loci that were amplified by the AmpF{(STR
SGM Plus® PCR Amplification Kit were determined for a total of 146 parent-offspring
allelic transfers (meioses) at the Forensic Science Service, Birmingham, England. One
length-based STR mutation was observed at the D18511 locus; mutations were not
detected at any of the other nine STR loci. The D18511 mutation was represented by an
increase of one 4-nt repeat unit, allele 17 was inherited as allele 18 (single-step
mutation). The maternal/paternal source of this mutation could not be distinguished.

Additional Additional studies (Edwards et al., 1991; Edwards et al., 1992; Weber and Wong, 1993;

mutation studies Hammond et al., 1994; Brinkmann ef al., 1995; Chakraborty et al., 1996; Chakraborty et
al., 1997; Brinkmann et al., 1998; Momhinweg ef al., 1998; Szibor et al., 1998) of direct
mutation rate counts produced:

* Larger sample sizes for some of the MiniFiler" Kit loci.

e Methods for modifications of these mutation rates (to infer mutation rates
indirectly for those loci where the rates are not large enough to be measured
directly and/or to account for those events undetectable as Mendelian errors).

Probability of identity

Table 10 shows the Probability of identity (Py) values of the MiniFiler" Kit loci
individually and combined. The P; value is the probability that two individuals
selected at random will have an identical MiniFiler " Kit genotype (Sensabaugh, 1982).
The P; values for the populations described in this section are then approximately
1/1.53 X 1010 (African-American), 1/1.22 X 10 10 (U.S. Caucasian), 1/9.57 X 10 9 (U.s.
Hispanic), and 1/4.82 X 10 ? (Native American).

Table 10 Probability of identity (P}) values for the MiniFiler™ Kit loci

Locus Afric:cm- Caucasian Hispanic Nati_ve
American American
CSF1PO 0.079 0.132 0.141 0.123
D251338 0.023 0.027 0.038 0.043
D75820 0.085 ' 0.063 0.083 0.081
D13S317 0.132 0.079 0.056 0.056
D16S539 0.077 0.097 0.090 0.082
D18S51 0.033 0.031 0.031 0.046
D21S11 0.037 ' 0.044 0.047 0.074
FGA 0.034 0.035 0.032 0.031
Combined 6.52 x 10°11 8.21 x 101 1.05 x 10-10 2.08 x 1010
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Probability of paternity exclusion

Table 11 shows the Probability of paternity exclusion (Pg) values of the MiniFiler™ Kit
STR loci individually and combined.

Table 11 Probability of paternity exclusion (Pg) values for the MiniFiler™ Kit loci

Locus Afric:cm- Caucasian Hispanic Nati_ve
American American

CSF1PO 0.545 0.496 0.450 0.409
D251338 0.748 0.725 0.671 0.399
D75820 0.591 ' 0.582 0.574 0.492
D13S317 0.383 0.487 0.638 0.370
D165539 0.649 0.566 0.567 0.428
D18S51 0.760 0.731 0.767 0.329
D21S11 0.737 ' 0.708 0.586 0.399
FGA 0.760 0.766 0.739 0.309
Combined 0.99985 0.99976 0.99970 0.98188

The Pg value is the probability, averaged over all possible mother-child pairs, that a
random alleged father will be excluded from paternity after DNA typing using the
MiniFiler" Kit STR loci (Chakraborty, Stivers, and Zhong, 1996).
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Section 5.2 Performance Validation After Buffer and
Enzyme Component Replacement

Overview

Experiments

98

As part of an ongoing program to exercise greater control over raw materials used in
the AmpF(STR® PCR Amplification Kits, manufacturing of the AmpliTaq Gold®
enzyme and 10X PCR Buffer II (Tris-KCl buffer) components is transitioning from
Roche Molecular Systems to Life Technologies. Manufacturing of both components by
Life Technologies will be conducted according to the same specifications used
previously by Roche. The in-house components are established raw materials in our
next generation kits (for example, the NGM™, NGM SElect and Identifiler® Plus
Kits).

We performed studies to compare the performance of the MiniFiler" Kit containing
the in-house components (updated kit) with the performance of the original kit,
focussing on studies most relevant to forensic DNA testing (see SWGDAM Guidelines
effective January 1, 2011). These studies, while not exhaustive, are in our opinion
appropriate for a manufacturer.

Our studies compared the performance of two Roche-manufactured enzyme and
buffer lots (Control mixes) with three new lots of buffer and two new lots of enzyme
manufactured by Life Technologies (Test mixes). Studies were performed using Test
mixes containing both the enzyme and buffer manufactured by Life Technologies.

Test_ Control Amix | Control B mix @ Test A mix Test B mix Test C mix
Material
Buffer Control Buffer | Control Buffer | Test Buffer Test Buffer Test Buffer
Lot 1 Lot 2 Lot 1 Lot 2 Lot 3
Enzyme Control Control TestEnzyme = Control TestEnzyme
Enzyme Enzyme Lot 1 Enzyme Lot 2
Lot 1 Lot 2 Lot 2

Each of the five mixes listed above were used to conduct reproducibility, sensitivity,
degraded DNA, and inhibition studies. All amplifications were performed using a
GeneAmp® PCR System 9700 with either silver or gold-plated silver block using the
recommended amplification conditions and cycle number for the MiniFiler"" Kit. All
data was run on an Applied Biosystems® 3130x! Genetic Analyzer running Data
Collection Software v3.0 and analyzed using GeneMapper® ID-X Software.
Subsequent data analysis was performed using Minitab® Statistical Software.
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Reproducibility study

For the reproducibility study, 12 replicates of control DNA 007 at 0.5 ng input and
three negative control replicates were amplified. The results were evaluated for
intracolor balance, stutter percentage, and the presence, signal intensity, and location
of artifacts.

Intracolor balance No significant difference (<10% increase or decrease) in the level of intracolor balance
was observed between the Test and Control mixes with the exception of Control B Mix,
which showed slightly increased levels of intracolor balance for the FAM™ dye (blue)
but decreased intracolor balance results for the PET® dye (red) (Figure 20). The levels
of intracolor balance obtained for all Test and Control mixes fall within the expected
range of performance for the MiniFiler " Kit.

Figure 20 Reproducibility study: intracolor balance
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Stutter Stutter percentage results for each marker were comparable across all Test and Control
percentages mixes (Figure 21).
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Artifacts

Figure 21 Reproducibility study: mean stutter percentage

Mean of Stutter Percentage

114

10

Amp Con

—&— Control A

—m—

— k-

Control B
Test &
TestB

TestC

i g Af L
7 . A
\ .
6 /, \ )‘A
A k!
5. hq/ y ﬁ{
4 R T T T T T T
\ o Ry il £ &F o5 o
) 4 o 5 ~ < (%
R SR S T R AR
B v G s L B i

Dye Color and Locus

Known artifacts observed showed the same morphology, signal intensity, and location

in all Test and Control mixes and do not exceed 50 RFU (Figure 22). No new artifacts

were observed in the Test mixes.

No artifacts were observed in the Test and Control mixes for the 6-FAM"" dye (blue),
NED™ dye (yellow), and PET® (red) dye. A very low level artifact was visible in the
VIC® (green) dye at ~115 bp for all Test and Control mixes but did not exceed 50 RFU.

Figure 22 Reproducibility study: known artifact VIC® dye (Y-scale 50 RFU)
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Sensitivity study

For the sensitivity study, dilution series of three genomic DNA samples were
amplified: 0.75 ng (three replicates), 0.5 ng, 0.25 ng, and 0.125 ng (four replicates each).
The results were evaluated for mean referenced peak height, degree of linearity
between input DNA concentration and peak height, level of allelic dropout at 125 pg,
and genotype concordance.

Mean referenced Overall mean referenced peak height observations were consistent between all Test
peak height and Control mixes (Figure 23) demonstrating equivalent performance (Figure 24).

Figure 23 Sensitivity study: mean peak heights for three genomic DNA samples
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Sensitivity study

Figure 24 Sensitivity study: representative electropherograms for Sample 2 amplified using 250 pg input DNA
(Y-scale 500 RFU)
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DNA concentration  The calculated slope and R? values for each of the plotted curves are equivalent,
and peak height showing comparable relationships between peak height and DNA input amount for
the Test and Control mixes (Figure 25).
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Allelic dropout

Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement

Sensitivity study

Figure 25 Sensitivity study: linear regression plot of combined mean peak height for three
genomic DNA samples
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Allelic dropout was only visible at 125 pg input DNA concentration. Levels of allelic
dropout at 125 pg were comparable across all Test and Control mixes and are
compared in Table 12. Examples of allelic dropout are shown in Figure 26 and

Figure 27.

Table 12 Sensitivity study: summary of allelic dropout observed at 125 pg input DNA

concentration

Number of Number of Percent of
. Number of
Reagent Mix samples alleles alleles alleles
P expected dropped dropped

Test A 3 51 2 L%

Test B 4 68 4 6%

Test C 4 68 2 3%
Control A 4 68 2 3%
Control B 4 68 4 6%

103

AmpFISTR® MiniFiler™ PCR Amplification Kit User Guide

o)
)
=
o
=
3
)
=]
o
@
5
o
o
=
o
=
98}
c
=
1]
=
o
=]
Q
m
S
N
<
3
@
20
)
joa
)
o
@
3
@
=]
=




104

Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement

Sensitivity study

Figure 26 Sensitivity study: electropherogram of 125 ng Sample 3 amplified with Control B Mix.
Two alleles are below the analysis threshold of 50 RFU: at the D185S51 locus in the NED™ dye
(yellow); at the FGA locus in the PET® dye (red) (Y-scale 400 RFU)
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Figure 27 Sensitivity study: electropherogram of 125 ng Sample 3 amplified with Test B Mix. One
allele at the D75820 locus in the FAM™ dye (blue) is below the analysis threshold of 50 RFU:
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Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement
Degraded DNA study

Genotype Genotypes for Test and Control mixes were 100% concordant (Table 13).

concordance Table 13 Sensitivity study: genotype concordance -
DNA Input Amount Reagent Mix Genotype Concordance %
125 pg Test A 100% g
Test B 100% 8
Test C 100% =
Control A 100% gg")'
Control B 100% w
250 pg Test A 100% oy
Test B 100% 5
Test C 100% =)
Control A 100% E
Control B 100% 5
500 pg Test A 100% §
Test B 100% 3
Test C 100% =

Control A 100%

Control B 100%

750 pg Test A 100%

Test B 100%

Test C 100%

Control A 100%

Control B 100%

Degraded DNA study

To reflect the specific design of the MiniFiler" Kit for degraded samples, 5 replicates of
0.5 ng degraded Control DNA 007 DNA and 5 replicates of 0.5 ng pristine Control
DNA 007 were amplified. Results were evaluated for intracolor balance, mean
referenced peak height, and levels of allelic dropout (degraded DNA replicates only).
Degraded DNA was prepared by first sonicating the DNA then treating with 1 U
DNAse I enzyme for increasing time increments to simulate increasing levels of
degradation. A final input DNA concentration of 500 pg was used for all
amplifications.

Intracolor balance No significant difference (<10% increase of decrease) in the level of intracolor balance
was observed between the Test and Control mixes on either degraded or pristine DNA
with the exception of Test A Mix, which showed higher levels of intracolor balance for
the NED"" (yellow) dye in degraded samples. The levels of intracolor balance obtained
for all Test and Control mixes fall within the expected range of performance for the
MiniFiler™ Kit.
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement

Degraded DNA study

Figure 28 Degraded DNA study: intracolor balance 0.5 ng input DNA amount
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Overall mean referenced peak height observations were consistent between all Test
and Control mixes with the exception of Test C Mix on pristine DNA, which showed
slightly higher referenced peak heights overall. The mean referenced peak height
results for all Test and Control mixes fall within the expected range of performance for
the MiniFiler " Kit.

Figure 29 Degraded DNA study: intracolor balance 0.5 ng input DNA amount
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Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement
Degraded DNA study

Allelic dropout

Simulated degraded samples showed an overall drop in peak height compared to

pristine DNA samples. Peak height of the higher molecular weight loci showed a
greater drop in peak height compared to lower molecular weight loci, in some cases
leading to allelic dropout. This is representative of the typical pattern observed in
partially degraded samples. Profile morphology and levels of allelic dropout were
comparable across all Test and Control mixes demonstrating equivalent performance.

Degraded DNA study: summary of Allelic Dropout observed at 125 pg input DNA concentration

Number of Number of Percent of
. Number of

Reagent Mix samoles alleles alleles alleles

P expected dropped dropped
Control A 5 85 3 4%
Control B 5 85 9 1%
Test A 5 85 12 14%
Test B 5 85 5 6%
Test C 5 85 13 15%

Figure 30 Degraded DNA study: representative electropherograms from 500 pg input DNA amplifications of simulated

degraded DNA samples (Y-scale 1000 RFU)
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement

Inhibition study

Figure 31 Degraded DNA study: representative electropherograms from 500 pg input DNA amplifications of pristine DNA
samples for comparison to simulated degraded samples (Y-scale 5000 RFU)
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An inhibition series of 0.5 ng control DNA 007 consisting of uninhibited control, humic
acid at a final concentration of 50 ng/uL, and hematin at a final concentration of 45 uM
in replicates of five were amplified using each of Test and Control mixes. The amount
of each inhibitor tested was titrated to cause an approximate 50% reduction in overall
peak height of the samples. Results were evaluated for mean peak height, minimum
peak height, intracolor balance, and levels of allelic dropout.

No significant difference in mean peak height or mean minimum peak height was
observed for any Test or Control mixes tested on Control DNA 007 inhibited with
hematin or humic acid. A significant increase in intracolor balance was observed only
for Control A Mix on Control DNA 007 inhibited with Hematin (Figure 32, 33, and 34).

More variation was seen in mean peak height, mean minimum peak height, and
intracolor balance on uninhibited DNA. This is not unexpected because the MiniFiler""
Kit was designed and developed for use on inhibited or degraded samples and is
optimized for performance on such sample types. All results obtained for all Test and
Control mixes fall within the expected range of performance for the MiniFiler'" Kit.
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Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement
Inhibition study

Figure 32 Inhibition study: mean referenced peak height
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Figure 33 Inhibition study: minimum referenced peak height
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Inhibition study

Figure 34 Inhibition study: intracolor balance
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Representative electropherograms from the inhibition study are shown in Figure 35,

Figure 36, and Figure 37.

Figure 35 Inhibition study: representative electropherograms using uninhibited Control DNA 007 (Y-scale 3000 RFU)
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Section 5.2 Performance Validation After Buffer and Enzyme Component Replacement
Inhibition study

Figure 36 Inhibition study: representative electropherograms using Control DNA 007 inhibited with 45 pM Hematin (Y-scale
3000 RFU)
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Chapter 5 Performance Validation After Buffer and Enzyme Component Replacement
Conclusions

Figure 37 Inhibition study: representative electropherograms using Control DNA 007 inhibited with 50 ng/pL Humic Acid
(Y-scale 4000 RFU)
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Allelic dropout

No allelic dropout events were seen for any Test or Control mixes tested on

uninhibited Control DNA 007 and Control DNA 007 inhibited with hematin or humic

acid.

Conclusions

112

Laboratories can expect to obtain equivalent quality profiles across a wide range of
forensic samples when using the MiniFiler" Kit containing the AmpliTaq Gold®
enzyme and 10X PCR Buffer Il manufactured by Life Technologies as compared to the
original MiniFiler" Kit containing AmpliTaq Gold® enzyme and 10X PCR Buffer II

manufactured by Roche Molecular Systems.
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that occur

during analysis.

Table 14 Troubleshooting

Observation

Possible causes

Recommended actions

Faint or no signal from
both the Control

DNA 007 and the DNA
test samples at all loci

Incorrect volume or absence of
Master Mix or Primer Set

Repeat amplification.

No activation of DNA Polymerase

Repeat amplification, making sure to hold
reactions initially at 95°C for 1 minute.

Master Mix not vortexed thoroughly
before aliquoting

Vortex the Master Mix thoroughly.

Primer Set exposed to too much light

Store the Primer Set protected from light.

PCR System malfunction

Refer to the thermal cycler user’s manual and
check instrument calibration.

Use of incorrect thermal cycling
parameters

Check the protocol for correct thermal cycling
parameters.

MicroAmp® Base used with tray/
retainer set and tubes in GeneAmp®
9700

Remove MicroAmp Base from tray/retainer set
and repeat test.

Insufficient PCR product
electrokinetically injected

Prepare PCR product as described in Chapter 3,
“Perform Electrophoresis” on page 25.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di™ Formamide.

Positive signal from
Control DNA 007 but
partial or no signal from
DNA test samples

Quantity of test DNA sample is below
assay sensitivity

Quantitate DNA and add 0.5 to 0.75 ng of DNA.
Repeat test.

Test sample contains high
concentration of PCR inhibitor (e.g.,
heme compounds, certain dyes)

Quantitate DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon®-100. Repeat
test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
re-amplify with an increased amount of DNA.

Dilution of test sample DNA in water
or wrong buffer (for example, wrong
EDTA concentration)

Redilute DNA using TE Buffer (with 0.1-mM
EDTA).
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Appendix A Troubleshooting

Observation

Possible causes

Recommended actions

More than two alleles
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Too much DNA in reaction

Use recommended amount of template DNA
(0.5 to 0.75 ng).

Mixed sample

Amplification of stutter product
(1 repeat unit position)

See “Stutter products” on page 75.

Incomplete 3° A base addition (n-1 nt
position)

See “Experiments and Results” on page 63. Be
sure to include the final extension step of 60°C for
5 minutes in the PCR.

Signal exceeds dynamic range of
instrument (off-scale data)

Ensure cycle number is optimized according to
instructions on page 19. Repeat PCR amplification
using fewer PCR cycles or use your laboratory’s
SOP to analyze off-scale data.

Poor spectral separation (bad matrix)

Follow the steps for creating a spectral file.

Confirm that Filter Set G5 modules are installed
and used for analysis.

Some but not all loci
visible on
electropherogram of
DNA Test Samples

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded, re-
amplify with an increased amount of DNA.

Test sample contains high
concentrations of a PCR inhibitor for
example, heme compounds, certain
dyes)

Quantitate DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon-100.
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The 3rd Order Least Squares Sizing
Method

You can use the 3rd Order Least Squares Sizing Method as an alternative to the Local
Southern method when analyzing MiniFiler" Kit data.

When to use

We recommend using the 3rd Order Least Squares method to size data obtained when
) q
analyzing MiniFiler"" Kit data using the GeneScan™ 500 LIZ® Size Standard.

The Least Squares methods (both 2nd Order and 3rd Order) use regression analysis to
build a best-fit size-calling curve. This method is used to extrapolate sizes that extend
beyond the physical range of the size standard. Small (< 75 nt) fragments generated by
the MiniFiler™ Kit can be sized using the GeneScan" 500 LIZ® Size Standard.

About the Local Southern algorithm

For the highest level of accuracy, the Local Southern method requires two
size-standard fragments below the smallest unknown fragment and two size-standard
fragments above the largest unknown fragment. All AmpF(STR® kits except the
MiniFiler" Kit, have an allele size range between 100 to 360 nt. Optimal genotyping
accuracy of all kits other than MiniFiler, require detection of all of the GeneScan™ 500
LI1Z® Size Standard (or ROX™) fragments between 75 and 450 nt (or 75 and 400 nt
depending on the kit).

In the MiniFiler"™ Kit, the amplicon sizes for the large AmpF(STR® loci have been
reduced to improve genotyping performance with degraded and inhibited DNA
samples. The allele range for the MiniFiler"" Kit is 70 to 283 nt. In order to use the Local
Southern algorithm, at least one peak <70 nt would have to be detected.

Although the GeneScan"" 500 LIZ® Size Standard does contain 50-nt and 35-nt
size-standard peaks, they are often difficult or impossible to detect. The fragments are
obscured by the primer front associated with the MiniFiler™" Kit amplifications.

Because fragment sizes cannot be extrapolated when using the Local Southern
algorithm, we recommend the 3rd Order Least Squares algorithm as an alternative
sizing method for the MiniFiler" Kit.

For a full description of the Least Squares Method refer to the GeneMapper® ID Software
Version 3.1 Human Identification Analysis: User Guide (Part no. 4338775).
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E Appendix B The 3rd Order Least Squares Sizing Method

Comparing genotyping accuracy

Comparing genotyping accuracy

We compared the Local Southern and 3rd Order Least Squares methods for
genotyping accuracy, using a data set of 1,156 Identifiler® Kit amplifications. The
amplified samples were from a single source, electrophoresed on an Applied
Biosystems® 3100 or 3130x! instruments, and sized with the GeneScan™ 500 LIZ® Size
Standard. The samples were analyzed using both sizing methods and their allele calls
were compared. The size standard definitions for both methods include all the peaks
from 75 to 450 nt, with the exception of the 250-nt peak.

The genotyping results (n=36,000 alleles) for the two methods were compared for
concordance. The genotyping accuracy rates for the Local Southern and 3rd Order
Least Squares algorithms were equivalent. No alleles were labeled with an incorrect
genotype and only a very small percentage (Local Southern, 0.05%; 3rd Order Least
Squares, 0.008%) of the alleles were designated as off-ladder when they did not
represent a true micovariant allele. All of the discordant off-ladder allele calls were
within 0.08 nt of the 0.5 nt off set for the bin sizing window.
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C Ordering Information

Equipment and materials not included

Table 15 Equipment

Equipment

Source

Applied Biosystems® 3100/3100-Avant Genetic Analyzer

Applied Biosystems® 3500/3500xL Genetic Analyzer

Contact your local Life
Technologies sales

representative
Applied Biosystems® 3130/3130x( Genetic Analyzer
Veriti® 96-Well Thermal Cycler 4375786
GeneAmp® PCR System 9700 with the Silver 96-Well Block N8050001
GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block 4314878
Silver 96-Well Sample Block N8050251
Gold-plated Silver 96-Well Sample Block 4314443
Tabletop centrifuge with 96-Well Plate Adapters (optional) MLS (major laboratory
supplier]
Table 16 User-supplied materials
Item? Source
AmpF(STR® MiniFiler™ PCR Amplification Kit 4373872
3100 Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x! Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4® Polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 402824
Hi-Di™ Formamide 4311320
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate N8010560
250-pL Glass Syringe (array-fill syringe) 4304470
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C Appendix C Ordering Information
Equipment and materials not included

ltemt Source

5.0-mL Glass Syringe (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100 instrument, refer to Appendix B of the 3100 Genetic Analyzer and
3100-Avant Genetic Analyzer User Reference Guide (Part no. 4335393).

3130x! Analyzer materials

96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x! Genetic Analyzer Capillary Array, 36-cm ' 4315931
POP-4® Polymer for 3130/3130x( Genetic Analyzers 4352755
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate . N8010560
Hi-Di™ Formamide 4311320

For a complete list of parts and accessories for the 3130x( instrument, refer to Appendix A of the Applied Biosystems®
3130/3130x( Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Part no. 4352716).

3500/3500xL Analyzer materials

Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
POP-4® polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4® polymer (384 samples) for 3500/3500xL Genetic Analyzers ' 4393715
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers ' 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers ' 4412614
Septa Cathode Buffer Container, 3500 series 4410715

For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems® 3500/3500xL
Genetic Analyzer User Guide (PN 4401661).
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Appendix C Ordering Information
Equipment and materials not included

Item? Source
310 Analyzer materials
310 DNA Analyzer capillary array, 47-cm 402839
0.5 mL sample tray 5572
96-well tray adaptor (for 9700 thermal cycler trays) 4305051
GeneScan™ 500 LIZ® Size Standard 4322682
OR OR
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 4335643
Genetic analyzer septa retainer clips for 96-tube sample tray 402866
Genetic analysis sample tubes (0.5-mL) 401957
Septa for 0.5-mL sample tubes 401956
DS-33 Matrix Standard Set (6-FAM™, VIC®, NED™, PET®, and LIZ® dyes) for 310/377 systems 4318159
MicroAmp® 8-tube strip, 0.2-mL N8010580
MicroAmp® 96-well base (holds 0.2-mL reaction tubes) N8010531
MicroAmp® 96-well full plate cover N8010550
MicroAmp® 96-well tray/retainer set 403081
POP-4® polymer for the 310 Genetic Analyzer 402838

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the 370 Genetic Analyzer User

Guide (Pub. no. 4317588).

PCR Amplification

MicroAmp® 96-Well Tray N8010541
MicroAmp® Reaction Tube with Cap, 0.2-mL N8010540
MicroAmp® 8-Tube Strip, 0.2-mL N8010580
MicroAmp® 8-Cap Strip N8010535
MicroAmp® 96-Well Tray/Retainer Set 403081
MicroAmp® 96-Well Base N8010531
MicroAmp® Clear Adhesive Film 4306311
MicroAmp® Optical Adhesive Film 4311971
MicroAmp® Optical 96-Well Reaction Plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
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C Appendix C Ordering Information
Equipment and materials not included

ltemt Source

Vortex MLS

t For the Safety Data Sheet (SDS) of any chemical not distributed by Life Technologies, contact the chemical manufacturer. Before handling any
chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
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Work area setup and labdesign............ ... 121
PCRsetupworkarea......... ... 121
Amplified DNA workarea ..., 122

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are
using an AmpF(STR® Kit for:

e Forensic DNA testing, refer to “Forensic Laboratories: Handbook for Facility
Planning, Design, Construction and Moving,” National Institute of Justice, 1998

* Parentage DNA testing, refer to the “Guidance for Standards for Parentage
Relationship Testing Laboratories,” American Association of Blood Banks, 7th
edition, 2004

The sensitivity of AmpF(STR® Kits (and other PCR-based tests) enables amplification
of minute quantities of DNA, necessitating precautions to avoid contamination of
samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by
human DNA. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area

IMPORTANT! These items should never leave the PCR Setup Work Area.

e Calculator

* Gloves, disposable

* Marker pen, permanent
¢ Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
¢ DPipettors
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Amplified DNA work area

¢ Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:
*  Veriti® 96-Well Thermal Cycler (Part no. 4375786)
* GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

IMPORTANT! The MiniFiler™ Kit is validated for use with the Veriti® 96-well Thermal
Cycler (Part no. 4375786) and the GeneAmp® PCR System 9700 with the silver block
(Part no. N8050251) or the gold-plated silver block (Part no. 4314443).

It is not verified for use with the Veriti® 96-Well Fast Thermal Cycler (Part no. 4375305)
or the GeneAmp® PCR System 9700 with the aluminium block (Part no. 4314879).
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.
Handle chemical wastes in a fume hood.

Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

After emptying a waste container, seal it with the cap provided.
Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.
IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Specific chemical CAS Chemical Phrase
handling
26628-22-8 | Sodium Azide Sodium azide may react with lead and copper
plumbing to form highly explosive metal azides.
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Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.

@ WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:
In the U.S.:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

® Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29cfr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

¢ Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:

Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization
(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
csr/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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Documentation and Support

Related documentation

Document title nF:lar:\tber

3100/3100-Avant Data Collection v2.0 User Guide 4347102
3100/3100-Avant Genetic Analyzers Using Data Collection Software v2.0 User Bulletin 4350218
3100 Genetic Analyzer User Manual (Data Collection v1.1) 4315834

3100/3100-Avant Genetic Analyzers Protocols for Processing AmpF(STR® PCR Amplification Kit PCR Products 4332345
User Bulletin

Applied Biosystems® 3130/3100x( Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
Applied Biosystems® 3130/3130xl Genetic Analyzers Getting Started Guide 4352715
Applied Biosystems® 3130/3130x Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
Applied Biosystems® 3130/3130xl Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems® 3130/3130x( Genetic Analyzers AB Navigator Software Administrator Guide 4359472
Applied Biosystems® 3130/3100xt DNA Analyzers User Guide 4331468
Applied Biosystems® 3500/3500xL. Genetic Analyzer Quick Reference Card 4401662

Applied Biosystems® 3500/3500xL Genetic Analyzer User Guide, Data Collection v1.0 4401661

Life Technologies 3500/3500xL Genetic Analyzer User Bulletin: Solutions to issues related to software, data, 4445098
hardware, and consumables

Note: Additional user bulletins may be available at www.lifetechnologies.com

Life Technologies 3730/3730x( Genetic Analyzer Getting Started Guide 4359476
GeneAmp® PCR System 9700 Base Module User’s Manual N805-0200
Quantifiler® Kits: Quantifiler® Human DNA Quantification Kit and Quantifiler® Y Human Male DNA 4344790
Quantification Kit User’s Manual

GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide 4338775
GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial 4335523
Installation Procedures and New Features for GeneMapper® ID Software v3.2 User Bulletin 4352543
GeneMapper® ID-X Software Version 1.0 Getting Started Guide 4375574
GeneMapper® ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper® ID-X Software Version 1.0 Reference Guide 4375671
GeneMapper® ID-X Software Version 1.1 [Mixture Analysis) Getting Started Guide 4396773
GeneMapper® ID-X Software Version 1.1 (Mixture Analysis] Quick Reference Guide 4402094
GeneMapper® ID-X Software Version 1.2 Reference Guide 4426481
GeneMapper® ID-X Software Version 1.2 Quick Reference Guide 4426482
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www.lifetechnologies.com

Documentation and Support
Obtain SDSs

Portable document format (PDF) versions of this guide and the documents listed
above are available at www.lifetechnologies.com.

Note: To open the user documentation available from the our web site, use the
Adobe® Acrobat® Reader® software available from www.adobe.com.

Obtain SDSs

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/support.

Note: For the SDSs of chemicals not distributed by Life Technologies, contact the
chemical manufacturer.

Obtain support

For HID support:

¢ In North America - Send an email to HIDTechSupport@lifetech.com, or call
888-821-4443 option 1.

* Outside North America — Contact your local support office.
For the latest services and support information for all locations, go to:
www.lifetechnologies.com

At the website, you can:

* Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

* Search through frequently asked questions (FAQs)
¢ Submit a question directly to Technical Support

® Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

¢ Obtain information about customer training

¢ Download software updates and patches

Limited Product Warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life

Technologies” website at www.lifetechnologies.com/termsandconditions. If you have
any questions, please contact Life Technologies at www.lifetechnologies.com/support.
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